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1

Introduction

Moxa MXview network management software gives you a convenient graphical representation of your
Ethernet network, and allows you to configure, monitor, and diagnose Moxa networking devices. MXview
provides an integrated management platform that can manage Moxa networking devices, such as Ethernet
switches, wireless APs, SNMP-enabled, and ICMP-enabled devices installed on subnets. MXview includes an
integrated MIB complier that supports any third-party MIB. It also allows you to monitor third-party OIDs
and Traps. Network and Trap components that have been located by MXview can be managed via web
browsers from both local and remote sites—anytime, anywhere.

The following topics are covered in this chapter:

O Key Features
» Web-based Operation
Auto Discovery and Topology Visualization

Event Management

vV V VYV

Configuration and Firmware Management
» Traffic Monitoring

0 MXview Operation Model

0 System Requirements

O Supported Devices
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Key Features

Web-

Auto

based Operation

MXview uses the client-server model. You will need to install the MXview server on a Windows computer
connected to the network(s) that are to be managed. After installing MXview, the network can be managed
with Chrome, Firefox, or Microsoft Edge (version 79+), without installing additional software.

Discovery and Topology Visualization

Within the scan range, MXview locates networking devices with SNMP or ICMP services enabled. MXview can
collect topology information from devices with LLDP capability and draw the topology of the network, which
shows physical connections. For ICMP devices without LLDP, MXview’s advanced auto-topology function can
verify the connection relationship through ARP algorithms, and help you create an accurate drawing of the
network topology. If any managed PoE switches are in your network, the PoE power output information will
also be visualized automatically.

Event Management

For troubleshooting purposes, MXview logs events that match predefined conditions, such as link up/down,
device unreachable, or traffic overloading. The most recent events will show up on the dashboard. Devices
and links that generate events will be highlighted with different colors. When an event occurs, users can be
notified in a number of different ways, including SMS, email, popup window, sound, or external program.

Configuration and Firmware Management

MXview provides an interface for managing Moxa networking devices from a central location. Users can
remotely backup or update configuration files, and upgrade firmware.

Traffic Monitoring

MXview can log the network traffic of network devices that have been discovered.

1-2
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MXview Operation Model

MXview is implemented as a web server to realize remote management through a single portal. The
following figure illustrates the operational model.

Server / Local User

B C
-

Remote User

sane

The MXview server runs in the background on a Windows PC and communicates with network devices using
Simple Network Management Protocol (SNMP) and a Moxa proprietary protocol that periodically polls
specific MIB data and stores data in a local database.

The MXview client uses web browsers to provide a uniform web interface that enables network operators to
access and operate over an intranet or the Internet.

System Requirements

The computer that MXview is installed on must satisfy the following system requirements:

System Requirements

CPU 2 GHz or faster dual core CPU
RAM 8 GB or higher

Hard Disk Space 20 GB or higher

0S Windows 7 Service Pack 1 (64-bit)

Windows 10 (64-bit)
Windows Server 2012 R2 (64-bit)
Windows Server 2016 (64-bit)

Client Browser Requirements Browser:

Chrome: Version 76 or later
Firefox: Version 69 or later
Microsoft Edge: Version 79 or later

Supported Devices

MXview supports a full range of functions, such as network status, traffic log, and configuration/firmware file
management.

e For other SNMP-enabled devices, MXview supports standard management functions, such as link up, link
down, and SNMP MIBII information.

e MXview can only monitor the connectivity of devices that support ICMP.
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Installation and System Backup

The following topics are covered in this chapter:

O Installation Procedure
O Uninstallation

O System Backup
a

System Restore
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Installation Procedure

1. Execute the installation program.

2. During the installation, you can choose the directory in which MXview will be installed and the default
language, or leave the settings at the default values.

You require a license to operate MXview, please check the License Chapter for more detail.

4. After the installation is complete, shortcuts for launching the MXview server will be created on the
desktop and in the start menu.

Uninstallation

1. Select Start > Control Panel

2. Under Programs, click Uninstall a program
The Uninstall or change a program screen appears
Select MXview

4. Click Uninstall or Uninstall/Change at the top of the program list

You can also uninstall the software by selecting
Start > All Programs > Moxa > MXview - Uninstall MXview

System Backup

Use the Database Backup screen on the MXview web console to back up the MXview database and
configuration files.

1. Navigate to Menu (E) - Migrations > Database Backup.
The Database Backup screen appears.

2. In the Name field, specify the backup directory.
Default directory: %MXviewPro_Data%\db_backup

3. Click Apply.
MXview exports the backup database to the specified directory.

The Database backup completed event will appear on the Recent Events list. Hover over the
Description to view the file path of the backup files.

Ack  Site Name D Source Source IP Device Alias Description Time Issued v

@ site 73 Mxview 0000 Database backup is completed, stored at %MXviewPRO_Data%\db_backuph | 2018-11-25 15:56:06

@ Site 72 MXview 0000 Auto Topology finished 2018-11-2501:13:54

The backup folder uses the following naming convention: YYYYMMDD HHMMSS

The system backup includes the following items:

e Topology

e Traffic

e Availability
e Event

e Threshold settings

e Job scheduler settings
e OID items

e Trap items

e System settings

2-2
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System Restore

MXview versions 2.2 and higher supports configuration backup files, which use the file extension *db3. To
restore a system configuration from a backup file, first shut down MXview. Then, select the DB Restore
tool in Start > All Programs > Moxa > MXview > DB Restore tool. Log in using your username and
password. Next, identify where the backup files are located: (1) MXview'’s archive repository, or (2) A
custom specific directory. Identify the folder where your backup files are located, and then click Restore.

The MXview system will restore the backup files.

This process is illustrated step-by-step below:

1. Select Start > All Programs > Moxa > MXview > DB Restore tool

e e e e aa g
. Launchy

.. Maintenance

I Microsoft Lync

|, Microsoft Office

L. Microsoft Silverlight
L Maoxa

L MXview

EY DB Restore tool

L& MXview Server

& Plug-in Manager for MXview 2.2

m Register Mxview to the Window:

7 Uninstall MXview

7 Un register MXwview to the Windo
. PComm Lite Verl.6

1 Back

Pictures

Music

Computer

Control Panel
Devices and Printers
Default Programs

Help and Support

2. Login with your username and password

CE )

Izert ame; I

Paszward: I

Canicel |
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3. Choose the folder where the backup files are located

, et rotons

Reztare from Miview's archive repogitony | Festare from a specific: folder |

Higtorical backups

D ate | Time |
2012/09/26 15:04:17
20124040 16:24:59

2012411202 i 3

Reztore | Cloze |

4. Click Restore.

Fiestore from Miview's archive repository Pestore from a specific folder |

Backup Folder:

D:t20121102 152833 |

Cloze

MXview versions 2.1 and earlier use *.dat backup files. To restore the system database and configuration
from a .dat file, use Project > Import MXview Configuration file, and then select the backup file to
restore.
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Getting Started

The following topics are covered in this chapter:

a

a
a
a
a

Q

Starting the MXview Server and Logging Into MXview Locally

Logging Into MXview Remotely

Multiple MXview Sites

Configuration of Multiple Sites

License Management

>

Checking the License

Using the Setup Wizard

>
>

Adding a New License

Deactivating a License

Account Management

>
>
>
>
>
>
>

Adding User Accounts
Modifying User Accounts
Deleting User Accounts
Exporting User Accounts
Configuring Account Passwords
Configuring Login Notifications

Changing the Display Language
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Starting the MXview Server and Logging Into
MXview Locally

Start MXview server on the computer before launching the MXview web console locally.

1.

On the server computer, double-click the MXview desktop shortcut.

The MXview server screen appears.

MXview ver 3.0

- Industrial Network
A\Y/[7"AV,"A Management Software
@CEL Moxa Inc. All rights reserved 2018.

Service IInfo ]

HTTP Port 80 [ Disable HTTP port
HTTPS Port 443 I

Comm. Port 8883
Database Port 5432
Polling Engine Port 4430

System Status: Stop

oK | Launch Browser Config Tool Stop & Quit

Configure the following port numbers:

HTTP Port: Specify the listening port of the server or use the default value of 80.
HTTPS Port: Specify the HTTPS port of the server or use the default value of 443.

Comm. Port: Specify the Remote Communication port of the server or use the default value of
8883.

Database Port: Specify the database port of the server or use the default value of 5432.

Polling Engine Port: Specify the polling engine port of the server or use the default value of 4430.

Click Start.

The MXview server starts running.
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4. To log in to the MXview web console from the server computer:

a. Click Launch Client.

The MXview web console appears.

Username

Password

Sign in

MXview

Network Management Software

| < App Store | o éooéle Play

Copyright © 2018 Moxa, Inc. All Rights
Reserved.

b. Provide the following login credentials
e Username: The default account is admin.
e Password: The default password is moxa.

The user account logs in to the MXview web console.

NOTE Alternatively, you can log in to MXview from a remote computer after starting the MXview service. For more

information, see Logging Into MXview Client.
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Logging Into MXview Remotely

Use the MXview Client to launch the MXview web console from a remote computer.

1. Open a web browser.

2. In the address bar, input the IP address or domain name of the MXview server.
e Format: http://[IP address]:[Port]
e Example: http://192.168.1.250:8080)

The MXview web console appears.

Username

Password

Sign in
MXview

Network Management Software

GETITON

| < E\pp Store | o Google Play

Copyright © 2018 Moxa, Inc. All Rights
Reserved.

3. Provide the following login credentials
e Username: The default account is admin.
e Password: The default password is moxa.

The user account logs in to the MXview web console.

NOTE A maximum of 10 users can log in to MXview at the same time.

NOTE For remote users, Moxa recommends downloading MXviewClient from the MXview server and using
MXviewClient to log in.
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Multiple MXview Sites

MXview can be configured to the distributed structure as the following figure shows. Users can monitor and
manage all of the MXview site at the master site at the same time. One MXview server can be configured to
connect to 10 MXview servers with 1 layer and MXview cannot be configured to be the master and client at

the same time.

Configuration of Multiple Sites

1. Click the Config Tool when MXview server stops running.

MXview ver 3.0

: Industrial Network
VI@W Management Software
@G Moxa Inc. Al rights reserved 2018.

Service |1.—.fD |

HTTP Port [s0 [~ Disable HTTP port
HTTPS Port |443

Comm. Port i 8883
Database Port | 5432
Polling Engine Port I4-43O

System Status: Stop

oK I Launch Browser Config Tool Stop & Quit




MXview 3.1.4

Getting Started

2. The control panel will pop up, choose the master if this MXview is configured to be the master to monitor

multiple instances of MXview.
I MXview *
‘Remote! Lacal

MXview Gateway Settings

Raole (® Master ) Client
Master Server IP 127001
Remaote Comm. Port 8883

Remote Comm. Port Password

Save Close

3. Choose Client if the MXview is the one to be monitored:

From V3.1.4, MXview supports pushing one client's data to two master MXview.

Enter the IP of the Master MXview on the Master Server IP, then, enter the remote communication port
of Remote Comm. port which showed at the master side at the Remote Comm. Port and the Remote
Comm. Password at the field, Remote Comm. Password, which also can be found at the local tab of

MXview server. Click ‘Add’ to add the master to the list.

A M Xview X

Remote |ocal

MXview Gateway Settings

Role () Master ® Client

Master Server IP 192.168.127.100

Remote Comm. Port 8883
Remote Comm. Port Password aaaabbbb

Ad

o

Modify

Master IP/Domain
Name

192.168.127.100 2883

Master Port

Save Close

To modify the master settings, select a row and the master data will be displayed in the upper textbox.

Click ‘Modify’ to update the settings to the table.

3
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IEview b

Remote  |gcal

MXview Gateway Settings

Raole () Master ® Client

Master Server IP 192.168.127.101

Remote Comm. Port 8882
Remote Comm. Port Password

| Add H Modify |

IMaster IP/Domain
Mame

Master Port

| Save | | Close |

The Local tab shows the port setting and password of MXview. The default password of the remote
communication port is 89191230, and the default database password is 89191230.

MXview b6

Remote Local
] Enable HTTP Port

HTTP Port
HTTPS Port
Polling Engine Port

Comm. Port

=]
=]
=]
w

Comm. Port Password

whddkhi |

Database Port

Database Password

EEREEELEY |
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License Management

MXview is available in different versions, and each version supports a different number of nodes. For
example, if your version of MXview supports 250 nodes, then during device discovery MXview will only
recognize up to 250 nodes. MXview will stop the device discovery procedure once it reaches the 250-node
limit.

The MXview license that you purchase specifies the node limit for that version of MXview. To increase the
node limit, you can purchase license upgrade and import the upgrade into MXview.

NOTE

Click "Start Free Trial" to start using MXview.

Checking the License

The License Manager screen displays information about your MXview license, including the number of
licensed nodes currently in use. You can also use the License Manager screen to add a new license or
deactivate an existing license.

To access the License Manager screen, navigate to Menu (E) - License.

License Manager

MXview 3.1 [ 7]

Free Trial Hetwork Adapter Re-activate License

m i i

The License Manager screen displays the license type, the number of nodes in use, and the total number
of nodes available under the current license.

Using the Setup Wizard

MXview provides a Setup Wizard to help administrators quickly determine the network topology and handle
basic configuration tasks. The wizard launches automatically when no network nodes have been configured.

1. To launch the Setup Wizard manually:
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a. Navigate to Menu (E) -> Wizard.

The Setup Wizard appears to the right of the navigation panel.
b. Select a site to set up from the Site Name drop-down list.
c. Click Next.

Setup Wizard

o Welcome to setup wizard

Welcome to setup wizard

This wizard will help you

1. Create Group

2. Set SNMP Setting

3. Add scan range

4. Draw Topology (with devices that support LLDP)

5. Set SNMP trap server

Please select a site to setup

2. Create groups to organize scanned devices into a multi-layer tree structure.

NOTE Before finding devices, groups need to be created. Root is the default group and the top-most layer in the
tree structure. All other created groups are placed below the level of Root.

a. Select the parent group.
b. Click Create to create a new group under the parent group.
c. Specify the following:

e Group Name: Type a name for the group.

e Group Description: Type a description for the group.

d. Click Apply.
MXview creates the new group below the selected parent group.
e. Click Next.

o Create Group

esRoot > Group Name

8”

Group Description

)

v/ Apply

+ Create W Delete

3. Configure the SNMP settings.
a. Specify the following (update default settings if necessary):
e SNMP Version: Default is "V1”
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e User Name: Provide the user name for the SNMP community string (if required)
e Password: Provide the password for the SNMP community string (if required)
¢ Read Community: Default is “public”
e Write Community: Default is “private”
e Data Encryption: Default is "NoAuth”
¢ Authentication: Default is “MD5”
¢ Encryption Key: Provide the encryption key (if required)
¢ Encryption Protocol: Default is DES (if required)
e SNMP Port: Default is 161
b. Click Next.

9 Set SNMP Setting

aamin

AuthPriv

AES d

4. Add the IP address ranges to scan for devices.

NOTE MXview supports scanning multiple IP address ranges. The selected IP address scan ranges must be enabled
in order for MXview to scan for devices.

a. Click the Add () icon.
The Add Scan Range screen appears.

b. Select one of the following options:
o Enabled: Select to enable scanning of the specified IP address range.
o Disabled: Select to disable scanning of the specified IP address range.
c. Configure the following:
e Provide a custom display Name for the scan range.
e Specify the First IP Address of the scan range.
e Specify the Last IP Address of the scan range.
e Select the CIDR Prefix for the scan range (if applicable).
e Select the MXview Group to assign the scan range to.
d. Click Apply.

e. (Optional) To add additional network scan ranges, repeat the previous steps.

f. (Optional) To modify scan range settings, click the Edit (#') icon next to an added scan range.
g. (Optional) To remove a scan range, click the Delete (i) icon next to the added scan range.
h. Select one or more scan ranges to scan.

i. Click Next.
MXview scans the specified IP address ranges for devices.
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o Add scan range

L]

Enabled/Disabled Name First IP Address Last IP Address Group Site Name

] Enabled - - . Root - -

5. (Optional) Recover devices ignored (deleted) from a previous scan:

NOTE If an IP address scan range is removed (deleted) from a previous network scan, MXview excludes devices
within the deleted range from the network topology. Use the Recovery feature to restore the devices from
deleted scan ranges to the network topology.

Select a device from the list of ignored devices.

b. Click Next.
MXview scans for network devices.

e Recover Ignore Devices

Recovery Device IP Site Name

6. View devices discovered on the network.

a. MXview displays discovered devices on the Device Result list. Scroll down to view more devices on
the list.

e Discovery Result

Device Alias Device IP Group Site Name

Root E

b. Click Next.
7. Draw the network topology.

NOTE MXview is only able to automatically draw the topology for LLDP devices. For devices without LLDP
functionality, the topology can be drawn manually after the wizard completes.

a. Select one of the following options:
e New Topology: Choose to draw a new topology and delete existing links.
e Update Topology: Choose to add new links to an existing topology.
b. (Optional) To perform an advanced topology analysis, which will analyze the connection on the ICMP
device. Then, select the Advanced Topology Analysis check box.
c. Click Next.
MXview draws the network topology.
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@ Draw Topology (for devices supporting LLDP)

(O New Topology

Existing links are going to be deleted

(® Update Topology

Existing links will be kept while new links are added
v Advanced Topology Analysis

*Additional time is required.

8. (Optional) Configure the SNMP trap server to capture real-time events.
a. Specify the following:
o Destination IP: Provide the IP address of the SNMP trap server.

¢ Community Name: Provide the community name of the SNMP trap server.

b. Click Next.

@ set SN trap server

Destination I1P1

Community Name1

9. Click Browse Topology to view the detailed network topology.
The Topology screen appears.

License Type

You can experience the power of MXview

Trial 2000 nodes within 60 days.

The free version of MXview is available for

Free Version Up to 20 nodes small-scale networks.

MXview provides license from 50 nodes to
2,000 nodes, which required you to have a

Full Version 50 - 2000 nodes registration code for your MXview, which
can be purchased from Moxa or Moxa's
partners.

If you have a full license but want to
increase the node, upgrading the license
can add nodes but is cheaper than the full
license.

Upgrade License 50 nodes

Close
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Adding a New License

To increase the node limit of your MXview server, you need upgrade the license. To upgrade your license,
obtain a valid activation code from your Moxa sales representative to add a new license.

1. Navigate to Menu (E) - License Manager.
The License Manager screen appears.

2. In the Add New License section, click Add New License.

License Manager

MXwiew 3.1 [
A =
L)
Add Mew License License Type
i e
L I d licensd e
Free Trial Network Adapter Re-activate License
STt 10 & # the L & licende 1 ] Lk & @l G
B ” = 3 L e ate

Start Free Trial Selec! Metwork Adapher Re-aclivate

3. Select the network adapter to generate the user code which will be used for license registration later.
The Activation screen appears.

4. Input a valid activation code.

Activation

User Code: 55DFBDEDAZCOD1EG241E
.'.'\.l' e |l . Oda

Cance

NOTE Please reference the license management page to get more details on how to get the activation code.

5. Click Apply.
MXview activates the new license.
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Deactivating a License

1. By using this process to Transfer the MXview license from the legacy device to the new device allows
users to deactivate the license to the new device.

2. Navigate to Menu (E) - License Manager.
The License Manager screen appears.

3. Expand the Licenses section.

A list of activated licenses and activation codes appears.

4. Click Deactivate.

License Manager

MXview 3.1
License: Authorized
I Current Modes / Licensed Nodes: 0/ 2000
P— Moxa License Site [
Add New License License Type
Licenses ~

License Type: MXview - 2000
Activation Code: tr2mILwk4CekZ7DhSIBiY2+hNKIIKGZ2ANCcvGV7i3Lgyy9Hs+F/1M3ahly41v6bcjPV30eBVfLnGLgLZ
wi7nY4bytAHGW3I1ErOuFxXLQUBITPNSMyaSXqulyWWAPAPtJeCNTOhwPOEDZPQKhDULVDts3wX9F78sMCAW/0Q
yimGK0ahOFIBFxD71JDY7buhD

Licensed Node: 2000

License Start: 2010/08/15 14:31:26 LIEIEE

Deactivated licenses

MXview deactivates the license.
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Account Management

The Account Management screen allows you to view, add, modify, and delete user accounts from MXview.
You can also export a list of user accounts and related information as a CSV file.

MXview provides three default accounts:

e admin
e user
e guest

Each account can be assigned one of the following Authority permissions:

¢ Administrator: Has full access rights to modify any settings/configurations and can assign authorities
to other accounts

e Supervisor: Has full access rights to modify any settings/configurations but cannot assign authorities to
other accounts

e User: Has read-only permission

Account Management

User Name Authority Accessible Sites

/s @ aomn Administratorr ste
- /S 8 user User Site Iy
/W g User an
Default User Name Default Password Authority
admin moxa Administrator
user moxa User
guest moxa User

Adding User Accounts

1. Navigate to Menu (E) - Account Management.
The Account Management screen appears.

2. Click the Add () icon in the top right corner of the screen.
The Add user account screen appears.

Add user account

Cance
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3. Configure the following account details:
e User Name: Specify the user name for the account
e Password: Specify the login password (minimum length: 4 characters) for the account
e Authority: Assign the authority permission (Administrator, Supervisor, or User) for the account
e Accessible Sites: Select which site(s) the account can access

4. Click Apply.

Modifying User Accounts

1. Navigate to Menu (E) - Account Management.
The Account Management screen appears.

2. Click the Edit (/') icon in front of the account you want to modify.
The Modify user account screen appears.

Maodify user account

guest

User -
Site THEO-LAID -

Cance

3. Modify the following account details:
e User Name: Specify the user name for the account
e Password: Specify the login password (minimum length: 4 characters) for the account
e Authority: Assign the authority permission (Administrator, Supervisor, or User) for the account
e Accessible Sites: Select which site(s) the account can access

4. Click Apply.

Deleting User Accounts

1. Navigate to Menu (E) - Account Management.
The Account Management screen appears.

2. (Optional) Select the check box(es) in front of one or more account(s).

3. Click the Delete (i) icon in front of the account you want to delete, or in the top right corner of the
screen (if multiple accounts are selected).
MXview deletes the account(s).
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Exporting User Accounts

The Account Management screen allows you to export a CSV file containing all user accounts with
corresponding authority permissions and accessible sites.

1. Navigate to Menu (E ) © Account Management.
The Account Management screen appears.

2. Click the Export (E) icon.

&l =

Export C5V

Select Export CSV.
4. Specify the location to save the configuration file.

Click Save.
MXview exports the CSV file to the specified location.

Configuring Account Passwords

Use the Preferences screen to modify the password requirements for user accounts.

1. Navigate to Menu (E ) > Preferences.
The Preferences screen appears.

2. In the User section, expand Password Policy.

Password Policy o

4
Password complexity strength check
D At least one digit (0~9)

D Mixed upper and lower case letters (A~Z, a~z)

[[] Atleast one special character (~1@#5%"&™-_|::. <>[1{}(})

Specify the minimum password length (between 4 to 16 characters).
4. Select one or more of the following password complexity requirements:

e At least one digit (~9)

e Mixed upper and lower case letters (A~2Z, a~z)

e At least one special character (~1@#$% A&*-_|;:,.<>[1{}())

5. Click Save.
MXview requires all new account passwords to satisfy the modified password policy.
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Configuring Login Notifications

Use the Preferences screen to customize the notifications displayed when users log in to MXview.
1. Navigate to Menu (E ) > Preferences.
The Preferences screen appears.

2. In the User section, expand Login Notification.
Login Notification =

+* Show Login Failure Records

+* Show Default Password Notification

3. To enable the following notification(s), select the corresponding checkbox(es):
e Show Login Failure Records
e Show Default Password Notification

4. To disable the following notification(s), clear the corresponding checkbox(es):
e Show Login Failure Records
e Show Default Password Notification

5. To display a custom login message, type a string (up to 250 characters in length) in the Login Message
field.

6. To display a custom login authentication failure message, type a string (up to 250 characters in length)
in the Login Authentication Failure Message field.

7. Click Save.
MXview displays the configured login notifications the next time a user logs in.
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Changing the Display Language
Use the Preferences screen to customize the notifications displayed when users log in to MXview.
1. Navigate to Menu (E) - Preferences.

The Preferences screen appears.

2. In the Display section, expand Language.

Display

Language

English A

3. From the Default Language drop-down list, select the new display language.
MXview supports the following languages:

e German (Deutsch)

e Japanese (H#:E

e English

e French (Frangais)

e Simplified Chinese (fgjfk=7)
e Traditional Chinese (8#&$7)

4. Click Save.
MXview updates the display language.
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License Management

The following topics are covered in this chapter:

O License Management Overview
0O Adding a New License

O Deactivating a License
a

Reactivating a Deactivated License
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License Management Overview

The License Manager screen displays information about your MXview license, including the number of
licensed nodes currently in use. You can also use the License Manager screen to add a new license or
deactivate an existing license.

To access the License Manager screen, navigate to Menu (E) - License.

License Manager

M¥view 3.1 7]
" e [
)
Mol Merwi Licenss License Types
Licenses o
Deactivated licenses W
Free Trial Network Adapter Re-activate License

m Selet Network Adapber Re-sclivate

The License Manager screen displays the license type, the number of nodes in use, and the total number
of nodes available under the current license.

Adding a New License

1. Navigate to Menu (E) - License Manager.
The License Manager screen appears.

2. In the Add New License section, click Add New License.

= MXview A Sterrummmres v

License Manager

MXview 3.1
‘ License: None
State: Trial does not activated yet
Current Nodes / Licensed Nodes: 0/ 0
: Moxa License Site (£

Add New License License Type

The Add New License screen appears.
3. Click Next.
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4. Select the network adapter to generate the user code which will be used for license registration later and
click Next.
If you have previously selected a network adapter, this step will not appear.

Add New License

Login Moxa License Select Network Copy User Code
i Adapter

Please select a Network Adapter’, MXview uses it to generate your user code

Select Adapters * -

Close

5. Copy the generated user code and click Next.

Add New License

Login Moxa License Select Network Copy User Code Activate
Site Adapter

Copy the User Code to Moxa License Site
|user Code: pmamasa s | |

Close m

6. Open a web browser and go to https://license.moxa.com and log in using your Moxa account.

7. Click Activate Your License.

MOX/\  Software Licensing

Activate Your License Query Your License Transfer Your License

8. Select MXview from the Software Package list.

MO /\ | Software Licensing

Home = Activate Your Software

Software Package

» MRC Quick Link = ioLogik E1200 EtherNet/IP
» MX-AOPC UA Logger
« MX-AOPC UA Server



https://license.moxa.com/

MXview 3.1.4 License Management

9. Select a license type:

MOX/\  Software Licensing B | Logout | Contactls

Home > Activate Vour Software > Software Package > MXview

For newuser (Activate Process Document)

Free Version
User Code:

« Paid Version
Registration Code:
User Code:
For 2.x version user

Current License:
User Code:

Submit

a. To register a Free Version:
i. In the For new user section, select the Free Version radio button.
ii. Paste the MXview user code into the User Code field.
iii. Click Submit.

b. To register a Paid Version:
i. In the For new user section, select the Paid Version radio button.
ii. Enter your MXview registration code into the Registration Code field.
iii. Paste the MXview user code into the User Code field.
iv. Click Submit.

c. To register a MXview 2.x Version:

NOTE This will convert the legacy v2.x license into a v3.0 license of the same type. A full v2.x license will upgrade

to a v3.0 full license while a v2.x upgrade license will convert to a v3.0 upgrade license. Legacy trial licenses
cannot be converted.

i. In the For 2.x version user section, select the radio button.

ii. Enter your MXview version 2.x legacy license into the Current License field.
You can view your MXview 2.x license in the MXview license manager.

iii. Paste the user code into the User Code field.
iv. Click Submit.
10. Download the license file.

MOXX/\  Software Licensing | e || @

Home > Acivate Your Software > Software Package > Mxview

Regisersd status Regisiration Code Registration Date
Registered e 51 - SN 2020-01-17

11. Open the license file with a text editor and copy the license key.
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12. In MXview, paste the license key into the Activation Code field.

Add New License

Login Moxa License Select Network Copy User Code Activate
Site Adapter

Download the license from Moxa License Site, and paste the Activation Code here.

Activation Code

Close

13. Click Apply.
MXview activates the new license.

Deactivating a License

If you want to transfer a license to a different instance of MXview, the license has to be deactivated first.

1. Navigate to Menu (E) - License Manager.
The License Manager screen appears.

2. Expand the Licenses section.

A list of activated licenses and activation codes appears.

3. Click Deactivate.

= MXviow A Site s v

License Manager

MXview 3.1

MXview deactivates the license.

Reactivating a Deactivated License

A deactivated license can be reactivated on the current instance of MXview or be transferred to a new

installation of MXview.

1. Navigate to Menu (E) - License Manager.
The License Manager screen appears.
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2. In the Re-activate License section, click Re-activate.

A, Site urE———

= MXview

License Manager

MXview 3.1
k License: None
State: Trial does not activated yet
Current Nodes / Licensed Nodes: 0/ 0
() Moxa License Site [
N
Add New License License Type
Free Trial Network Adapter Re-activate License

Start to experience the power of MXview
within 60 days

MXview binds the license to one
network adapter, please choose the
adapter you want to bind. Re-select a
network adapter will deactivate all your
licenses automatically, you have to
register them again.

Use both the Deactivation code and a
User Code to re-activate your license.

Select Network Adapter Re-activate
The Re-activate License screen appears.
3. Click Next.
4. Copy the deactivation code and click Next.
Reactivate License Wizard
Link to License Copy Deactivate Copy User Code Generate License
Server Code

Copy your Deactivate Code and paste on License Server

Deactivaten Code| B sl . SNy M S L i = LR L

e

L Rkt e e ()

' ™™ T I FRE L T
ol e LSRR |

% T P el B

5. Open a web browser and go to https://license.moxa.com and log in using your Moxa account.

6. Click Transfer Your License.

MOXN\

Software Licensing

| Logout | ContactUs

Activate Your License Query Your License

Transfer Your License

7. Click Transfer to another Device.

MOXN\

Software Licensing

Home > Transfer License

=2

Transfer to
another Device

Transfer to

&3

another User Account
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8. Select MXview from the Software Product list.

MOX/\ | Sofiware Licensing

Home > Transfer License = Transfer to another Device

Software Product

Deactivation Code™ | |

New User Code* | |

9. Paste the deactivation code MXview into the Deactivation Code field.

MOX/\ | Software Licensing

Home > Transfer License > Transfer to another Device

Software Product: MXview M

Deactivation Code” |

New User Code” | |

10. In MXview, copy the user code and click Next. If you are transferring the license to a different MXview
instance, run the Add New License wizard on the new instance and copy the user code.

Re-activate License

o /] 3] o

Login Moxa License Copy Deactivate Copy User Code Activate
Site Code

Copy the User Code to Moxa License Site .
User Code i it p s 1 10 IQ

CIose m

11. Paste the MXview user code into the New User Code field.

MOX/\ | Software Licensing

Home > Transfer License > Transfer to another Device

Software Product

Deactivation Code*

Mew User Code™ |

Submit

12. Click Submit.

13. Download the license file.

MO /\  Software Licensing ut | ComtactDs

Home * Activate Your Sofware * Software Package » MXview

Registerd siatus Regisiration Gode Registation e
Registered L T 2020-01-17
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14.

15.

16.

Open the license file with a text editor and copy the license key.

In MXview, paste the license key into the Activation Code field.

Re-activate License

Login Moxa License Copy Deactivate Copy User Code Activate
Site Code

Download the license from Moxa License Site , and paste the Activation Code here.

Code

Close

Click Apply.
MXview activates the license.
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Dashboard Widgets

The MXview Dashboard contains several widgets that provide summary information about your network
devices, event highlights, and server disk space utilization.

The following topics are covered in this chapter:

Dashboard Overview

Device Summary

Device Availability

Event Highlights: Cold/Warm Start Trap
Event Highlights: ICMP Unreachable
Event Highlights: Link Down

aQaoaaogaaaoaa

Disk Space Utilization



MXview 3.1.4 Dashboard Widgets

Dashboard Overview

Use the Dashboard to gain a quick overview of your network devices, important system events, and server

disk space utilization.

The Dashboard displays the following widgets:

Device Summary

Device Availability

Event Highlights: Cold/Warm Start Trap
Event Highlights: ICMP Unreachable
Event Highlights: Link Down

Disk Space Utilization

To access the Dashboard, navigate to Menu (E) - Dashboard.

To refresh the data displayed in all the widgets, click the Settings ( { ) icon in the top right corner of the
screen and select Refresh All.

Device Summary

The Device Summary widget displays the following information about the devices on your network:

Total Devices: The total number of devices detected on your network.

Click to view additional details about the devices on the Network Topology screen.
Healthy Devices: The number of devices with no critical events or warnings.

Click to view additional details about the devices on the Network Topology screen.
Critical Devices: The number of devices with critical events.

Click to view additional details about the devices on the Network Topology screen.
Warning Devices: The number of devices with warnings.

Click to view additional details about the devices on the Network Topology screen.

You can perform the following actions on this widget:

To view a visualization of the devices in your network topology, click View Network Topology.
For more information, see Topology Management.

To refresh the widget data, click the Refresh (C) button following the Last Update timestamp.

Device Summary Last Upcate: 2018/11/23 18:51:37 (¥

= -
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Device Availability

The Device Availability widget displays the availability of each device in your network topology. MXview
calculates device availability by using the following formula:

Availability = (Uptime / (Uptime + Downtime)) x 100
To refresh the widget data, click the Refresh (C) button following the Last Update timestamp.

Device Availability @ Last Update: 2018/11/28 19:03:53 (%

192.168.127.1--IKS-6726A
1921681271 100.00%
Site THEO-LAIOA

192.168.127.2--IKS-6728A-8POE
192.1668.127.2 100.00%
Site THEO-LAICA

192.168.127.3--EDS-G516E
192.168.127.3 100.00%
Site THEO-LAIOA

192.168.127.4--EDS-G516E
192.166.127 .4 100.00%
Site THEO-LAIOA

Event Highlights: Cold/Warm Start Trap

The Event Highlights: Cold/Warm Start Trap widget displays the number of cold start traps and warm
start traps issued by devices at a site, and the day on which the events occurred.

You can perform the following actions on this widget:

e To view the number of cold/warm start traps issued at a site on a specific date, hover over a bar in the
widget chart.
e To view additional details about the event on the All Event screen, click a bar on the widget chart.

e To change the type of event that the widget displays information for, select a different event type from
the drop-down list in the top left corner of the widget.

e To refresh the widget data, click the Refresh (G) button following the Last Update timestamp.

Event Highlights Last Update: 2018/11/28 19:17:53 (¥

Cold/Warm Start trap ~

ez Rk
Hisite THEO-LAIDT: 1

Count

1122 11123 1124 1125 11/26 1127 11/28
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Event Highlights: ICMP Unreachable

The Event Highlights: ICMP Unreachable widget displays the number times an ICMP-enabled device on
your network was unreachable, and the day on which the events occurred.

You can perform the following actions on this widget:

To view the number of "ICMP unreachable” events issued at a site on a specific date, hover over a bar in
the widget chart.

To view additional details about the event on the All Event screen, click a bar on the widget chart.

To change the type of event that the widget displays information for, select a different event type from
the drop-down list in the top left corner of the widget.

To refresh the widget data, click the Refresh (G) button following the Last Update timestamp.

Event Highlights Last Update: 2018/11/28 19:31:37 (¥

ICMP unreachable -

Count

1122 1123 1124 1125 1126 1127 11/28
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Event Highlights: Link Down

The Event Highlights: Link Down widget displays the number of times a port link was down on a device
on a specific date.

You can perform the following actions on this widget:

e To view the number of “link down” events issued at a site on a specific date, hover over a bar in the
widget chart.
e To view additional details about the event on the All Event screen, click a bar on the widget chart.

e To change the type of event that the widget displays information for, select a different event type from
the drop-down list in the top left corner of the widget.

o To refresh the widget data, click the Refresh () button following the Last Update timestamp.

Event Highlights Last Update: 2018/11/23 19:25:38 (¥

Link down -

30

25

20

Count
o

0— -

1122 11/23 11/24 11/25 11/26 1127 11/28

Disk Space Utilization

The Disk Space Utilization widget displays information about how much storage capacity is still available on
the MXview server computer.

To refresh the widget data, click the Refresh (C) button following the Last Update timestamp.

Disk Space Utilization Last Update: 2018/11/28 20:0110 (2

® used Free

97.22%

190 N R
FAVRVR ]
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Device Discovery and Polling

The following topics are covered in this chapter:

O Device Discovery Overview
Configuring IP Address Scan Ranges
Configuring Background Discovery

Configuring Device Polling Settings

QQaaa

Changing Default SNMP Configurations
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Device Discovery and Polling

Device Discovery Overview

MXview uses SNMP and ICMP to discover devices within the scan ranges. When a Moxa device has been

located, MXview will generate an actual image of the device, demonstrated below, to indicate the device’s

location on the network.

MXview will also list detailed properties and configuration parameters, including the following:

e MAC Address

e Model Name

e IP Address

e Netmask

e Gateway

e Trap Server Address

e Auto IP Configuration

e Type of Redundancy Protocol

e Role in Redundancy Protocol

e Status and Properties of the Port

e Power Status

e Status and Version of the SNMP Protocol

MXview will display one of the following graphics to indicate devices:

Device

Image

Moxa devices with SNMP enabled.

MO XA

Non-Moxa devices with SNMP enabled.

=

Non-Moxa devices with ICMP enabled.

le

Configuring IP Address Scan Ranges

MXview allows you to scan multiple ranges of IP addresses within your network. Each network range is
defined by a starting IP address and an ending IP address. Use the Scan Range Wizard to configure

network scan ranges.

1. Access the Scan Range Wizard screen by the following method:

a. Navigate to Menu (E) - Network > Scan Range.
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b. Navigate to Menu (E) - Network 2 Topology, and then navigate to Topology 2> Scan Range
from the Topology Map toolbar menu.

I <o Topology v [

Scan Range

jo.

2

Auto Topology
= Auto Layout

The Scan Range Wizard screen will appear.

Scan Range Wizard

@ nNetworkRange @ Recover lgnors Devicss @ Discovey Resu O complets
Enabled/Disabled Name First IP Address Last IP Address Group Site Name
/7 W Enabled 2 1234 1234 Root Site THEO-LAIDT
/' . Enzbled demo 192168127 1 192168 127 220 Root Site THEO-LAIOT

2total

2. To add a new scan range:

a. Click the Add () button in the top right corner.
The Add Scan Range screen will appear.

Add Scan Range
Enabled -
test

192.168.127.1 /24 (255.255.2550) -

192.168.127.254

Root -

b. Select the scan range status:

e Enabled

e Disabled

Provide a Name for the scan range.

Provide the starting IP address for the scan range.
Provide the ending IP address for the scan range.
Select the CIDR Prefix (if any).

Assign the scan range to a Group.

> a ™ o a o

Click Apply.
The new scan range appears in the Network Range table.

3. To edit a scan range:
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a. Select the check box next to the scan range in the Network Range table.

b. Click the Edit (#") icon.
The Add Scan Range screen appears.

c. Modify the scan range settings.

d. Click Apply.
The Scan Range Wizard screen displays the Network Range table with the updated scan range
information.

4. o recover previously deleted devices and discover new devices in the scan range:

a. Click Next.
The Scan Range Wizard screen displays the Recover Ignore Devices tab.

Scan Range Wizard

o Network Range Recover Ignore Devices

Recovery  Device IP Site Name:

[ 1 1234 Site THEO-LAID1
v [} 192.168.127.100 Site THEO-LAIO1
[ 1 192.168.127 195 Site THEO-LAIO!

b. Select the device(s) you want to recover.

c. Click Next.
The Scan Range Wizard screen displays the Discovery Result tab.

d. Wait for device discovery to finish.
The Discovery Result tab displays newly discovered devices (if any) from the scan range.

Scan Range Wizard

o Network Range Q Recaver Ignore Devices

Device Alias Device IP Group Site Name:

5. To complete scan range configuration, click Next.
The Scan Range Wizard screen displays the Complete tab and the number of devices added to
MXview.

Scan Range Wizard

o Network Range o Recover Ignore Devices o Discovery Result
There are 0 added to MXview

Browse Topology

6. To view the updated topology, click Browse Topology.
The Network Topology screen will appear and display the updated Topology Map.
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Configuring Background Discovery

Background Discovery automatically scans configured IP address scan ranges every 30 minutes to detect if
any new devices have been added.

NOTE Background Discovery requires configuring IP address scan ranges. For more information, see Configuring
IP Address Scan Ranges.

1. Navigate to Menu (E) - Preferences.
The Preferences screen will appear.

2. In the Advanced section, expand System Configuration.
The System Configuration settings will appear.

Advanced
System Configuration =

Disabled A

3. To enable Background Discovery:
a. Select Enabled from the Background Discovery drop-down list.

Click Save.
MXview scans the configured IP address scan ranges every 30 minutes for new devices.

4. To disable Background Discovery:
Select Disabled from the Background Discovery drop-down list.

b. Click Save.
MXview stops scanning the configured IP address scan ranges every 30 minutes for new devices.
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Configuring Device Polling Settings

Devices in the assigned scan range can be discovered via SNMP and ICMP protocols. (The default polling
interval of ICMP is 10 seconds, while SNMP is 60 seconds. Users can go to the preferences page to change
the polling intervals.) After a device is discovered, MXview will use SNMP and ICMP to poll the device
periodically. To configure this function properly, you will need to know the following information:

e The IP addresses of the devices on the network.

e The Read community name assigned to the devices on the network.

NOTE MXview Dashboard widgets also use the device polling settings. For more information about the MXview
Dashboard widgets, see Chapter4: Dashboard Overview.

1. Navigate to Menu (E) - Preferences.
The Preferences screen appears.

2. In the Advanced section, expand Device.

The Device settings appear.

Advanced
System Configuration v

Device

admin
24

3. Configure the following ICMP polling settings:
e ICMP polling interval: Specify the time in seconds between polls

e Consecutive failure to trigger ICMP unreachable event: Specify the number of failed attempts
before triggering the event

4. Configure the following SNMP polling settings:
e SNMP polling interval: Specify the time in seconds between polls

e Consecutive failure to trigger SNMP unreachable event: Specify the number of failed attempts
before triggering the event

5. Configure the device web console login credentials:
e Username: The login username for the device web console
e Password: The login password for the device web console
Configure the timeframe (in hours) for calculating device availability.

7. Click Save.
MXview will update the device polling settings.
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Changing Default SNMP Configurations

The default SNMP read community string that is used to discover devices is public. Use the Preferences
screen to change the default read community string or modify other default SNMP configurations.

1. Navigate to Menu (E) - Preferences.
The Preferences screen will appear.

2. In the Advanced section, expand SNMP Configuration.
The SNMP Configuration settings will appear.

Advanced

3. Configure the following:
e SNMP Version: Select the SNMP protocol version
e User Name: Specify the SNMP server username
e Password: Specify the SNMP server password
¢ Read Community: Specify the new community string
e Write Community: Specify the new community string
o Data Encryption: Select the data encryption method (NoAuth, AuthNoPriv, AuthPriv)
e Authentication: Select the authentication method (MD5, SHA)
e Encryption Key: Specify the encryption key
e Encryption Protocol: Select the encryption protocol (DES, AES)
e SNMP Port: Specify the SNMP port

4. Click Save.
MXview updates the modified settings.
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Topology Management

MXview allows you to view a graphical representation of your network topology, add/delete devices and
links to the Topology Map, organize the topology structure, and export the Topology Map as a PNG image.
You can also scan specific IP address ranges to discover devices on your network.

The following topics are covered in this chapter:

Network Topology Overview

Viewing Topology Map

Viewing Recent Events

Organizing the Topology Structure
Redundant Topologies

PoE Power Consumption Visualization
VPN Tunnel Visualization

PRP/HSR Visualization

Third-Party Icons

Port Trunking

Adding Devices and Links

Deleting Devices and Links

Updating the Topology Map
Refreshing the Topology Layout
Creating a New Topology Map
Setting/Deleting the Background Image
Editing the Topology Appearance

Editing the Device Appearance

oo uoooo0oogogoogaogaoaogaogaoaaoaaa

Exporting the Topology Map
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Network Topology Overview

The Network Topology screen allows you to view the Topology Map, which is a graphical representation of
the devices in your network, and perform most actions in MXview. For example, you can use the Network
Topology screen to do the following:

e Display a graphical representation of a real network.
e Show connecting relationships between devices.

e Indicate the status of devices and links.

= MXview i 20
ALL > Site tanistseng-PC > Root >

A Toployyv @ Gowv S Eity @ Visuslzation v =

Q

192.168.127.9 192168\27.19  192.16£.127.107

192.168.127.104

|

192.168.127.100

o site Name ) Souce  SourcelP Device Allas Description Time Issued

17573 Mxview  127.001

o ® B stetnissengpe 17572 Mxview  192168127.39 102.168.127.39-1EX-402-VDSL2 Device ICMP unreachable 20191211 09:28:38

Viewing Topology Map

Use the Network Topology screen to view the Topology Map and export a PNG image of the Topology
Map.

1. Navigate to Menu (E) - Network - Topology.
The Network Topology screen will appear and displays the Topology Map by default.

2. If List view is selected, click the Topology view () icon in the top right corner.
The Network Topology screen will display a graphical representation of the devices and links on your
network.

3. To search the Topology Map for a specific device:
a. Click the magnifying glass () icon in the top left corner.

The topology search box appears with a drop-down directory tree of the Topology Map structure.

Search topology

| Q

G0 165,127 .1--IKS-6726A

197 165127 2--IKS-672__.

m 192.168.127 3--EDS-G5..
‘! 192.168.127 4--EDS-G5..

b. Locate the device in the drop-down directory tree or type a string in the search box.
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4. To view the details of a specific device, select the device in the Topology Map.

The Device Properties pane appears to the right of the Topology Map.

Device Properties Current Status

Basic Device Properties

Alias
192.168.127.2-EDS-518E

Model Name
EDS-518E

Mac Address
0090E85B1363

5. To view events associated with the device, click the right arrow (>) > Current Status.
The Current Status pane displays events associated with the device.

£ fes Current Status b

Mo events

6. To view details about a link between devices, select a link in your Topology Map.

Ring 1 Master
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The Link Properties pane appears to the right of the Topology Map.

M
i

From
192168127 1

Port 26

To
192166127 2

Port 25

Viewing Recent Events

Use the Network Topology screen to view recent events from devices in your topology. You can filter the
events in the list or export the data as a CSV file.

For more information on viewing all events, see Chapter 10: Event Monitoring.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and displays the Recent Events panel on the bottom.

ALL > Site tanistseng-PC > Root >

A Topology v @ Gowpv S Edtv @ Visulzation v =
s |
192.168.127.247,

== @3 Q

o Site Name. » Souce  SourcelP. Device Alias Description Time ssued

o ® B stetnistsengpe 17573 Mxview 127001 User login: admin 20191211 09:28:49
o e B stetanistsengpe 17572 Mxview 19216812730 192.168.127.30-EX-402-VDSL2 Device ICMP unreachable 20101211 09:28:38
o® B stetenists: 7571 Mxview 192168127253 Device SNMP unreachable 20101211 09:28:35
o® B sitetnsts 17570 Mxview  192168127.247 192.168.127.2: Device S 20101211 09:28:34
o ® B sictanstsenge 17569 Mxview 192168127245 192.168.127.245-AWK1131A Device SNMP unreachable 2019121 09:2833
o ® B sietanstsengpe 17568 Mxview 192168127239 192.168.127.239-AWK1131A Device SNMP unreachable 20191211 09:28:32
o® B sietanistsengpe 1756 Mxview 192168127205 192.168.127.205-Ethenet Device Device SNMP unreachable 20191211 09:28:31
o e B stetanistsengpc 17566 Mxdew 192168127199 192168.127.199-£05-4054 Device SNMP unveachable 201912:11 09:28:30
o ® B stetanistsengpe 1755 Mxvew  192168127.188 192.168.127.186-£DS-G516E Device SNMP unveachable 201912711 092824

2. To filter the information in the table, type a full or partial string that matches the value in any of the
table columns.
MXview filters the table to only display events with values that fully or partially match the specified
string.
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3. To filter the information in the table by specific criteria:

a. Click the Filter (7)) icon below the Recent Events tab.
The criteria selection screen appears.

(]

I
=%
(=N
©
w
w

Reset Apply

b. Specify any of the following criteria:
e Severity: Select the event severity level
e IP Address: Select the device IP address
e Group: Select the device group
e Source: Select the source that detected the event (MXview, Trap, or Security Sensing)
c. Click Apply.
MXview filters the table to only display events that match the specified criteria.
4. To filter the information in the table by event acknowledgement (Ack) status:
Click the envelope () icon below the Recent Events tab.

b. Select the event acknowledgement status from the list that appears.
MXview filters the table to only display events that match the selected acknowledgement status.

5. To sort the data in the table by a specific column, click the column heading.
MXview sorts the table by the column.

6. To export data displayed in the Recent Events tab:
a. Click the Export (E) icon.

= M &

Export CSV

b. Select Export CSV.
c. Specify the location to save the exported file.

d. Click Save.
MXview exports the displayed event data as a CSV file.
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Organizing the Topology Structure

The Topology Map can be organized into a multi-layer tree structure of up to 5 layers. Organizing the
topology structure into groups helps manage a large number of nodes on the computer screen. For
example, users can move nodes of the same subnet or location into the same group. Root, which is the only

group at the first layer, exists by default and cannot be deleted. Groups created by users are in the layer
under Root. Devices can be moved between groups.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.

e MXview represents the Topology Map structure by a path at the top of the Network Topology
screen:

ALL > Site THEO-LAIO1 > Root »

e If the Topology Map contains groups under the Root layer, you can click the right arrow (>) and
select the group:

ALL > Site THEO-LAIOT > Root

ALL > Site THEO-LAIO1 > Root
o Topology 8 Group v |
: Group1

e You can also click the following icon used to indicate user-defined groups within the Topology Map:

Groupt

2. If List view is selected, click the Topology view () icon in the top right corner.
The Network Topology screen displays the following toolbar above the Topology Map:
o Topology v & Grouwp v # Edit~ @ Visualization v
3. To create a group:

a. Navigate to Group > Create Group.
The Create Group screen appears.

Create Group

Parent Group
Root hd
Group Name

sroup Descripton

Close
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b. Configure the following:
e Parent Group
e Group Name
e Group Description

c. Click OK.
MXview will add the group below to the specified parent group.

4. To reorganize the groups within the Topology Map structure:

a. Navigate to Group > Group Maintenance.
The Group Maintenance screen appears.

Group Maintenance

¥ ARoo

aeGroupl

Close

b. Select a layer to modify.
The group details appear to the right of the topology directory tree.

Group Maintenance

¥ SRoot

&GroupT Group Name
Group Description %
The top layer group
~ Apply
C aate

Close

o

Edit the group details or perform one of the following points:

o

(Optional) Click Create to add a new group below the selected layer.

e. (Optional) Click Delete to remove a group from the topology structure.

Click Apply.
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5. To reassign the device(s) in a group:

a. Navigate to Group > Change Group.
The Change Group screen appears.

Change Group

Root -

IP Address

192.168.127.1
192.168.127.2
192.168.127.3

192.168.127.4

Group1 v

Cancel

b. If the IP Address list does not display the IP address(es) of the device(s) you want to reassign,
select the source group from the Current Group drop-down list.

c. Select the IP address(es) of the device(s) that you want to reassign to a different group.
d. From the Assign to Group drop-down list, select the new group for the selected device(s).

e. Click Apply.
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Redundant Topologies

Redundant topologies have at least one backup link, which will be indicated with a dashed line:

pe =¥
Fe o

1%3'188.12?.10? 192 168127,
_f"p? pa
."I
pe 7
o
.’I
-
192 B2 M27.109 1921628 (127,105
=xy e
[ut=] =xy
Magter
tl
1921 Ee.12?.11§? p§92.1m.12?.1n4
2 =

192465127 110

For devices that play a particular role in the topology, MXview will label the devices by displaying the roles
above the images of the devices. Backup links will be indicated with dashed lines.

e RSTP has a Root

e Turbo Ring has a Master

e Turbo Chain has a Head and a Tail

NOTE Only auto topology can draw dashed lines for redundancy links. Manually drawn redundant links will appear
as solid lines.

PoE Power Consumption Visualization

By periodic polling, a PoE link will display the port number, power (watts), voltage (V), and current (mA)
directly on the topology map.

Ring 1 Master e .-

192.168.129.2 port 4 pd
P AW [ 54V 1 TEmA

1921681293 192.168.129.2p5
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VPN Tunnel Visualization

The VPN tunnel link will be indicated using different colored lines, as shown below. An icon in one of three
different colors indicates VPN statuses:

Blue: All VPN tunnels are connected

2B A2 2547 StaTost et

—

Firaweal
_=—__;— _ _13?15_8127.’_&!54&05112 WPH
— - ——1
MR e 1REEAED — S — - Totaosted” |
e Yellow: At least one VPN tunnel is disconnected

i 192,163 122 254 / SiteTo Site 1
(2

e

Firawa
152968 122 258 [ stetosite
=

s L2

Red: All VPN tunnels are disconnected

132 188 122 254 / SiteTosSke

Fit el
182 188 122 254 [ sfelosile VBN

p3
oletosites 182188127 245

NOTE

VPN Tunnel Visualization is only available on Moxa’s EDR-810 series of secure routers.

PRP/HSR Visualization

MXview is able to indicate different roles of PRP/HSR technology, including PRP, HSR, Coupling, and
Quadbox. The links of PRP/Coupling LAN A, LAN B, and HSR Ring are indicated with different colored lines.

Port INT Coupling

PortB  PortA

Coupling

Port INT
PortINT port INT

PoriB  PortA

B8.127.115

168127113

192.168.127.104

192168127103
NOTE

PRP/HSR Visualization is only available with Moxa’s PT-G503 and PT-7728-PTP Series. (PT-7728-PTP support
starts at version 2.9)
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Third-Party Icons

MXview is able to support most network devices, even those made by many different vendors. Below is an
example of a network which includes Moxa devices and a Cisco device. MXview will change the device icon
to indicate that the device is a Cisco device.

Vendors with MXview support includes: ABB, CISCO, Emerson, Hirschmann, Rockwell, Schneider, and
Siemens.

EeEEEEE

Port Trunking

Port trunking, also called link aggregation, involves grouping links into a link aggregation group. Trunking
links will be indicated with thick, solid lines.

. - e
s Hﬁm i an

CLELS

192168127 .2 192.168.127 1

NOTE Only auto topology can draw thick lines for trunking links. Manually drawn trunking links will appear as solid

lines.

NOTE For trunked link, check “Device Properties” to get the port number corresponding to the trunking group.

----- w| Port 29 Tk Group 1 Port 25 (Link up) / Port 26 (Link up)
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Adding Devices and Links

MXview allows you to manually add devices and links to an automatically generated Topology Map. The
Network Topology screen allows you to add devices from Topology View or List View.

For information about List View, see Chapter 9: Device Management > Viewing the Device List.

1.

Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.

To add a device to the Topology Map:

a. Click Edit > Add Device.
The Add Device screen will appear.

Add Device

public private

b. Configure the following:
e IP Address: Specify the IP address of the device
e Assign Model: Select the model of the device
e Assign To Group: Select the group to assign the device to
e SNMP Version: Select the SNMP version
e User Name: Specify the device login user name
e Password: Specify the password
e Read Community: Specify the SNMP read community string
e Write Community: Specify the SNMP write community string
¢« Data Encryption: Select the data encryption method
¢ Authentication: Select the authentication method
e Encryption Key: Specify the encryption key

c. Click Add.
MXview adds the device to the topology.
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3. To add a link to the Topology Map:
a. Navigate to Edit > Add Link.
The Add Link screen will appear.

Add Link

Cancel Apply

b. Configure the following information for the two devices joined by the link:
e Device: Specify the IP address of the device
e Port: Specify the device port number

c. Click Apply.
MXview adds the link between the specified devices.

NOTE Links drawn between two devices in the Topology Map are bidirectional. You may specify either device as
the From device or the To device.

NOTE Trunking and redundancy links added manually will appear as solid lines.

NOTE Port numbers must be numeric and entered correctly to obtain the correct traffic information.

NOTE For modular switches, a port number depends on the chassis to which the port belongs, but not on how

many modules are inserted. For switches such as the PT-7828, the first module’s port numbers are from 1
to 8, the second module’s port humbers are from 9 to 16, and so on. The port number depends only on
which slot the module is in; in other words, the port number is the same regardless of whether other slots
are empty or occupied.
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Deleting Devices and Links

You can delete devices and links from the Topology Map. After a device is deleted, it will be removed from
the topology map and scan range, and the device will not be polled or located when performing device
discovery. Deleting a link will delete a link from the topology map, but it will not affect the actual network
configuration.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and display the Topology Map by default.

2. To delete a device from the Topology Map:

a. Select the device.
The following toolbar menu will appear.

\R Maintenance v ‘\ Tools v /‘ Change Group . Document (@ Refresh 9 Locator GD Add Link E Delete

b. Click Delete.
A confirmation screen will appear.

c. Click OK.
MXview deletes the device from the Topology Map.

3. To delete a link from the Topology Map:

a. Select the link.
The following toolbar menu will appear.

FR Link Traffic v X Severity Threshold [ Set Port Label B Delete

b. Click Delete.
A confirmation screen will appear.

c. Click OK.
MXview deletes the link from the Topology Map.
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Updating the Topology Map

Updating the existing topology adds new links and updates existing links, but does not change the status of
links that are indicated as having been disconnected or links that were drawn manually.

For devices with LLDP functionality, MXview can draw the physical topology map, down to the port level of
the devices. For devices without an LLDP MIB, MXview is able to draw links by using ARP. To activate this
function, select the Advanced Topology Analysis checkbox from the Auto Topology screen.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.

2. If List view is selected, click the Topology view () icon in the top right corner.
The Network Topology screen displays a graphical representation of the devices and links on your
network.

3. Navigate to Topology > Auto Topology.
The Auto Topology screen appears.

Auto Topology
(O New Topology
Existing links are going to be deleted

(® Update Topology

Existing links will be kept while new links are added

Advanced Topology Analysis o
[0 Strict Link Verification Mode @

*Additional time is required.

Cance‘ m

4. Select Update Topology.
(Optional) Select Advanced Topology Analysis to draw links for devices without an LLDP MIB.

6. Click OK.
MXview will update the Topology Map.
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Refreshing the Topology Layout

After changes have been made, use the Auto Layout feature to refresh the layout of the Topology Map.
Auto Layout does not update any devices or links. It only redraws the topology to better fit the screen.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and displays the Topology Map by default.

2. If List view is selected, click the Topology view () icon in the top right corner.
The Network Topology screen will display a graphical representation of the devices and links on your
network.

3. Navigate to Topology > Auto Layout.
The Auto Layout screen appears.

Auto Layout

Are you sure you want to do Auto Layout?
(Current layout will be overridden)

Close OK

4. Click OK.
MXview refreshes the Topology Map layout.
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Creating a New Topology Map

Creating a new topology deletes all links, requests LLDP information from devices, and draws topology maps
based on the gathered information.

For devices with LLDP functionality, MXview can draw the physical topology map, down to the port level of
the devices. For devices without an LLDP MIB, MXview is able to draw links by using ARP. To activate this
function, select the Advanced Topology Analysis checkbox from the Auto Topology screen.

NOTE Links drawn manually will also be deleted by this action.

NOTE Your devices must have firmware version 3.1 or higher to use Advanced Topology Analysis.

NOTE If the Auto Topology function does not create an accurate representation of the actual network, deselect the
Advanced Topology Analysis check box and try again.

NOTE Strict Link Verification Mode" checks the LLDP table of both ends of the devices and draws a link if and only
if the link data is included in both devices.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.

2. If List view is selected, click the Topology view () icon in the top right corner.
The Network Topology screen displays a graphical representation of the devices and links on your
network.

3. Navigate to Topology > Auto Topology.
The Auto Topology screen appears.

Auto Topology

(® New Topology

Existing links are going to be deleted

O Update Topology

Existing links will be kept while new links are added

Advanced Topology Analysis o
[ Strict Link Verification Mode ﬂ

*Additional time is required

Cance‘ m

4. Select New Topology.
(Optional) Select Advanced Topology Analysis to draw links for devices without an LLDP MIB.

6. Click OK.
MXview will create a new Topology Map.
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Setting/Deleting the Background Image

MXview allows you to customize the Topology Map by uploading a background image in JPG, GIF, or PNG
format.
1. Navigate to Menu (E) - Network > Topology.

The Network Topology screen appears and will display the Topology Map by default.

2. If List view is selected, click the Topology view () icon in the top right corner.
The Network Topology screen will display a graphical representation of the devices and links on your

network.
3. Navigate to Edit > Set Background.
The Set Background screen appears.

Set Back&round

Drag a image here or browse to set background

Close

4. Upload the background image by using one of the following methods:
e Drag and drop an image file into designated area on the Set Background screen.
e Click browse on the Set Background screen to locate the file on your local machine.
MXview will set the uploaded image as the Topology Map background.

5. To delete a background image, navigate to Edit > Delete Background and click OK.
MXview will remove the background image from the Topology Map.

Editing the Topology Appearance

Use the Preferences screen to modify how the Topology Map displays the topology line style, PoE status,
background color, link status, and traffic load.

1. Navigate to Menu (E) - Preferences.
The Preferences screen appears.

2. In the Display section, expand Topology Appearance.
The Topology Appearance settings appear.

Language v

| Topology Appearance

Directed Line Style A

Directed Line Style  Elbow Line Style
PoE
D Show PoE Status on Topology

PoE Link Color - #FFO00D
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3. To modify the Topology Line Style, select one of the following from the drop-down list:

Topology Appearance

Directed Liﬁeétﬂe 10| | ,
—d e

Directed Line Style Elbow Line Style

* Directed Line Style
MXview applies the following style to the lines indicating the links between devices in the Topology
Map:

Directed Line Style

e Elbow Line Style
MXview applies the following style to the lines indicating the links between devices in the Topology
Map:

Elbow Line Style

4. To modify how MXview displays Power-over-Ethernet (PoE) links:

a. Select the Show PoE Status on Topology check box to indicate the PoE link status on the Topology
Map.

PoE
+" Show PoE Status on Topology

PoE Link Color - #FFOO00
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b. Click the PoE Link Color field and specify a new color.

C

PoE

v Show PoE Status on Topology

PoE Link Color - #FFODOD

a7

Background

Background Color [_] srFreFF

Status Color

Link Up Link Down
#000000 #FFO000
Turbo Ring V1 Turbo Ring V2

#f0000

4k

Hex

(Optional) Clear the Show PoE Status on Topology check box to hide the PoE link status on the

Topology Map.
PoE
D Show PoE Status on Topology

PoE Link Color - #FFOO0D

5. To modify the Topology Map background, click the Background Color field and specify a new color.

Background
Background Color|[ ] #FrrerF
Status Color N
Link Up Link Down
#0D00000 #FFOOOOD
Turbo Ring V1 Turbo Ring V2
| |
#000000 #000000
Turbo Chain RSTP
| |

Faiiiinii

4w

Hex

6. To modify the color used to indicate the status of specific links in the Topology Map, click to modify the

Status Color hex code for any of the following links:

Link Up

Link Down

Turbo Ring V1
Turbo Ring V2
Turbo Chain

RSTP

PRP/Coupling LAN A
PRP/Coupling LAN B
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e HSR Ring
Status Color

Link Up
||

#000000

Link Down

#FF0000

Turbo Ring V1

Turbo Ring V2

Boooooo #000000
Turbo Chain RSTP
|| ||
#000000 #000000
PRP/Coupling LAN A PRP/Coupling LAN B
[ | [
#0000FF #008000
HSR Ring
#500080
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7. To modify the colors used to indicate the traffic load levels:
a. Check the Traffic Load legend and click Edit.

Traffic Load
0 20 40 a0 a0 100

The Edit Traffic Load Color screen will appear.
Edit Traffic Load color

0-20

023894

[ +1EBOEE

A5 @®r omm
- #023894 C
[ £F6AB00 e

80-100

W E60012

Close Apply
b. Modify the color used to indicate a traffic load (%) range.
c. Click Apply.
8. Click Save.
MXview will update the modified settings.
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Editing the Device Appearance

Use the Preferences screen to modify how devices appear in the Topology Map.

1. Navigate to Menu (E) - Preferences.
The Preferences screen will appear.

2. In the Display section, expand Device Appearance.
The Device Appearance settings will appear.

Language v
Topology Appearance v
~

Device Appearance

Preview
IP Address
None v
Alias
Botiom Labe " B Labe
|IP Address - Model Name -

3. To modify the label that indicates the device in the Topology Map:
a. Locate the Bottom Label drop-down list located below the Preview image:

Device Appearance

Preview
IP Address
Bottom Caoet
None -
Alias
pottom Labe + Boitom Labe
IP Address - Model Name -
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b. Select one of the following properties from the Bottom Label drop-down:
¢ Location
e Alias
e Model Name
e MAC

MXview displays the selected property below the IP address of the device.

Device Appearance

Preview

IP Address

Bottom Label
p——

Location v

4. To modify the device alias:

a. Locate the Alias section.

Device Appearance

Preview
IF Address

Location
Bottom Label [}
Location bt
Alias
Bottom Labe o Bottom Labe
IP Address - Model Name v

b. From the first drop-down list in the Alias section, select one of the following:
e IP Address
e MAC
e Model Name
¢ Location
¢ SysName
c. From the second drop-down list in the Alias section, select one of the following:
e IP Address
e MAC
e Model Name
¢ Location
¢ SysName

5. Click Save.
MXview updates the modified settings.
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Exporting the Topology Map

MXview allows you to export the Topology Map as a PNG image.

1. Navigate to Menu (E) - Network - Topology.
The Network Topology screen appears and displays the Topology Map by default.

2. If List view is selected, click the Topology view () icon in the top right corner.
The Network Topology screen will display a graphical representation of the devices and links on your
network.
Navigate to Edit > Export Topology.

4. Specify the location to save the exported file.

Click Save.
MXview exports the PNG image of the Topology Map to the specified location.
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Network and Traffic Monitoring

MXview allows you to monitor the traffic between devices on your network and trigger events for specific
traffic conditions. You can apply topology views to monitor traffic load, network security, wireless access
points and clients, and also visualize VLAN connections.

The following topics are covered in this chapter:

Viewing Link Properties

Viewing Port Traffic

Viewing Packet Error Rates

Monitoring Traffic Loads

Monitoring Network Security

Visualizing VLAN Connections

Monitoring Wireless Access Points and Clients

Configuring Severity Thresholds for Traffic Monitoring Events

Qaoaoaaogoooaa

Configuring Custom Port Labels
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Viewing Link Properties

Click a link on the Topology Map to view link properties and perform the following:

1. Navigate to Menu (E) - Network - Topology.

The Network Topology screen will appear and display the Topology Map by default.
2. Click on a link between devices in the Topology Map.

The Link Properties pane appears to the right of the Topology Map.

N Hi,admin £
ALL > Site MXstudio-PC > Root

@ nkTficy X Sevrity Threshol a
Q

Link Information
Sos0ara
Ports

220276

Port13

,,,,,,,

Viewing Port Traffic

The Port Traffic screen displays a graph that shows the utilization percentage (Y-axis) over a specific time
period (X-axis). You can also adjust the time period for the data that is displayed by changing the starting
date and ending date. The minimum interval you can select is one day.

1. Navigate to Menu (E) - Network > Topology.

The Network Topology screen appears and displays the Topology Map by default.
2. Click on a link between devices in the Topology Map.

The Link Properties pane and the following toolbar appear when a link is selected.

&R Link Traffic v X Severity Threshold B SetPort Label B Delete

3. Navigate to Link Traffic > Port Traffic.
The Port Traffic screen will appear.

Port Traffic

O 12M19/2018 HO 12/19/2018 ol

0.012

=]
(=]
=

=
=
=
[==]
a

Utilization %

0.006
06:00 12:00 18:00

4. To adjust the time period for the graph data:
a. Click the From date and select a new starting date.

b. Click the To date and select a new ending date.
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Hover over a line to view the direction of traffic.
For example, the green line at the top of the following graph represents traffic from 192.168.127.1
(device IP address) Port 26 to 192.168.127.2 (device IP address) Port 25.

Port Traffic

@ 12/19/2018 I'-"IO 121972018 =

2018/12119 11:20:10
0.012

. 0.01

=

c

=)

g

Z0.008

i
0.006

06:00 12:00 18:00

Close

Viewing Packet Error Rates

The Packet Error Rate screen displays a graph that shows the packet error rate (Y-axis) over a specific
time period (X-axis). You can also adjust the time period for the data that is displayed by changing the start
and end dates. The minimum interval is one day.

1.

Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.

Click on a link between devices in the Topology Map.
The Link Properties pane and toolbar appear when a link is selected.

@B Link Traffic v ~X Severity Threshold B Sct Port Label B Delete
Navigate to Link Traffic > Packet Error Rate.
The Packet Error Rate screen appears.

Packet Error Rate

s

O 12/19/2018 F'lo 12/19/2018 =

Facket Error Rate %
[
I

06:00 12:00 18:00

Close
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5. To adjust the time period for the graph data:

a. Click the From date and select a new starting date.

b. Click the To date and select a nhew ending date.

Monitoring Traffic Loads

MXview collects the traffic load information of every link and displays the information to provide users with a
network-wide view.

1.

Navigate to Menu (E) - Network > Topology.

The Network Topology screen will appear and displays the Topology Map by default.

If List view is selected, click the Topology view (%) icon in the top right corner.

The Network Topology screen will display a graphical representation of the devices and links on your
network.

From the toolbar menu, navigate to Visualization > Traffic View.

The Traffic Load legend will appear and the Topology Map color-codes each link to indicate the traffic
load.

Ring 1 Master Traffic Load(%) (] X

: :
16e127.121 100768 1273 0 20 40 60 80 100

<1ps <1 <k

> <

v
4

<1f <1

pl <1% <1% pl p9 <1%

>« >4

>«
168.127.4 192.168.127.2

To modify the colors used to indicate the traffic load levels:

a. Navigate to Menu (E) - Preferences.
The Preferences screen will appear.

b. Under the Display section, expand Topology Appearance.
c. Locate the Traffic Load legend and click Edit.

Traffic Load
0 20 40 60 a0 100
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The Edit Traffic Load Color screen appears.

Edit Traffic Load color

4023894

[ #1EB9EE
B 414A83B . E am =
#023894 :
[ £F6AB00 e
B 4E60012
Close Apply

d. Modify the color used to indicate a traffic load (%) range.

e. Click Apply.

Monitoring Network Security

ISA/IEC 62443 is a continuously evolving cybersecurity standard whose guidelines have already been
adopted in many industrial automation applications. This standard, including its subsections, aims to cover
points such as general requirements, policies and procedure, system-level requirements, and component-
level requirements.

Moxa’s MXview follows Moxa’s security guidelines, which are based on the current IEC 62443-4-2
component-level recommendations. Security View checks the security level of Moxa’s network devices.
There are five levels for checking the results in Security View:

e High: IEC 62443-4-2 level 2

e Medium: IEC 62443-4-2 level 1
e Basic: General baseline

e Open: Security Level below basic

e Unknown: Devices without security-related information for Mxview

NOTE The definition of general baseline is based on several industrial cybersecurity policies and requirements.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and display the Topology Map by default.
2. If List view is selected, click the Topology view () icon in the top right corner.
The Network Topology screen will display a graphical representation of the devices and links on your

network.
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3. From the toolbar menu, navigate to Visualization - Security View.
The Security View window will appear and the Topology Map indicates the security level of each device
with a color-coded circle.

= MXview Hi,admin 3

ALL > Site MXstudio-PC > Root >

\ Maintenance v \ Tools v /' Change Group B Document C Refresh Q locator G AddLink B Delete = (]

Security View (&) = X 1t Status Security View

Device Security Level: Medium

High Medium Basic open  unknown
@ Basic / General Baseline
Ring 1 Master
14 result of filter "All" ~ ® Medium / [EC 62443-4-2 Level 1
@ High / IEC 62443-4-2 Level 2
v . 20.20.27 5-EDS-516A - o

+ @ o Change Defaut Password / o

20.20.27.6 SNMP Community String

20.20.27.6-EDS516A Hd

u 20.20.27.7 .

Set SNMP Trap/Inform or Syslog
000 sorer ®

20.20.27.7-NPort $8000

20.2027.8 & @ @ Enable Trusted Access °

20.20.27.8-NPort $8000

® @@ Enable Auto Logout

Enable Broadcast Storm
®® protection

Enable Password Complexity

e @ & Q@

[ Type to filter event Strength Check
Ack  Site Name ) Source Source IP Device Alias Descrip
Enable Account Login Failure
| A 8 v soon . o oo cnnnosc cocnean oo ®® Lockeut v

4. To filter the devices in the Security View window by security level:
Click the Filter (&) icon.

Select the security level.
The Security View window filters the list of devices to only show devices that match the selected

o o

security level.
5. To locate a device in the Topology Map, click the device in the Security View window.
ALL > Site MXstudio-PC > Root >

9 Maintenance v | Tools v /' Change (

Security View e = 4
High  Medum  Basic Open  Unknown
14 result of filter "All" &

v -5

20.20275-EDS-516A
20.20.27.6
20.2027.6-EDS-516A
20.20.27.7
20.20.27.7-NPort $8000
20.20.27.8
20.20.27.8-NPort $8000

o
o o =




MXview 3.1.4 Network and Traffic Monitoring

The Security View details pane will appear on the right and the Topology Map highlights the circle
around the device.

B Delete = (i)

Q locator GO AddLink

Device Security Level: Medium
Basic / General Baseline

@ Medium / IEC 62443-4-2 Level 1

@ High / IEC 62443-4-2 Level 2

@ ® SNMP Community String

Server

@ @ Enable Auto Logout

Enable Broadcast Storm
®® Protection

Enable Password Complexity
®® Strength Check
Device Alias Descrip
Enable Account Login Failure
®® | ockout

Change Default Password / ©
Set SNMP Trap/inform or Syslog. g

@ @ Enable Trusted Access 9

@ & 0 9

View security details for a specific device by using one of the following methods:

e Select a device from the Topology Map.

e Select a device from the Security View window.

The Security View details pane will appear and displays the device security level and security-related

configuration statuses.

7. Review the following items in the Security View details pane:

Item

Description

Enable Auto Logout

Check if the Auto Logout function is enabled or not

Set Login Message

Check if the Login Message is configured or not

Disable Non-encrypted TCP/UDP Ports

Check if Non-encrypted TCP/UDP Ports are disabled or not

Enable Account Login Failure Lockout

Check if the Account Login Failure Lockout function is enabled
or not

Enable Trusted Access

Check if the Trusted Access function is enabled or not

Enable Password Complexity Strength
Check

Check if the Password Complexity Strength Check function is
enabled or not

Enable Configuration File Encryption

Check if the Configuration File Encryption function is enabled or
not

Enable Broadcast Storm Protection

Check if the Broadcast Storm Protection function is enabled or
not

Set SNMP Trap/Inform or Syslog
Server

Check if the SNMP Trap/Inform or Syslog Server is set or not

Change Default Password/SNMP
Community String

Check if the Default Password or SNMP Community String is set
or not
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8. To modify the colors used to indicate the security levels:

a.

d.

Navigate to Menu (E) - Preferences.
The Preferences screen will appear.

Under the Display section, expand Security View.

In the Colors for check result section, modify the color used to indicate a security level.

Security View

Built-in Profile

¥ Profile details [4

Colors for check result

High / IEC 62443-4-2 Level 2

Medium / IEC 62443-4-2 Level 1

#02A36B #3BTFCT
Basic / General Baseline Open
#FF992B #C0OCOCO
Click Save.

9. To define a custom security profile:

a.

Navigate to Menu (E) - Preferences.

Under the Display section, expand Security View.

From the Profile drop-down list, select User-defined.
The user-defined profile settings will appear.

Security View

The Preferences screen will appear.

User defined -

Colors for check resuilt

. #02A368

#FF9928

%]

Check Item

Enable Auto Logout

Set Login Message

e Device Server
¢ Gateway

e Wireless

(Optional) Modify the colors for the check result.

8-8

(Optional) Click the Settings (1_-5) icon to select a baseline.
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Click one of the following device tabs to configure the profile settings:
e Switch

Select the check box for each item you want to add to security profile.
Click Save.
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Visualizing VLAN Connections

Moxa switches support 802.1Q tagged VLAN. MXview collects each device’s VLAN configuration and
integrates the information with color-coded visualization to provide a network-wide view.

1. Navigate to Menu (E) - Network > Topology.

The Network Topology screen appears and displays the Topology Map by default.

2. If List view is selected, click the Topology view () icon in the top right corner.

The Network Topology screen displays a graphical representation of the devices and links on your
network.

3. From the toolbar menu, navigate to Visualization > VLAN View.

The VLAN View window appears.

) Hi, admin §

ALL > Site MXstudio-PC > Root >

A Topologyv @ Gowv ) Eity @ Visualizstion v

(=)

5

4. Selecting a specific VLAN ID.

MXview indicates devices, ports, and links that are associated with the VLAN ID using color-coded
circles.

Monitoring Wireless Access Points and Clients

MXview collects the wireless information from all the Moxa AWK series devices, and displays the information
on the Wireless Table View screen.

Use the Wireless Table View screen to view the following information:

e The number of wireless access points in your topology

Column Description

Device Name The device name of the access point
IP Address The IP address of the access point
MAC Address The MAC address of the access point
Modulation The modulation of the access point

e The number of wireless clients in your topology

Column Description

Online The connection status of the client

Device Name The device name of the client

IP Address The IP address of the client

MAC Address The MAC address of the client

Signal Strength (dBM) The signal strength of the client in dBM
SNR (db) The signal-to-noise ratio of the client in db

NOTE

The Wireless Table View screen only supports the AWK-1131A Series, AWK-3131A Series, and AWK-4131A
Series devices.
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NOTE The dashboard can only show AWK devices as APs and clients. It does not support third-party clients.

NOTE The Wireless Table View screen refreshes automatically every 15 seconds.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and displays the Topology Map by default.

2. If List view is selected, click the Topology view ( *) icon in the top right corner.
The Network Topology screen will display a graphical representation of the devices and links on your

network.
3. From the toolbar menu, navigate to Visualization > Wireless Table View.

The Wireless Table View screen appears.

4. To view details for a specific device, select the device from the table.

The wireless device details pane appears.

Configuring Severity Thresholds for Traffic
Monitoring Events

MXview allows you to configure the following traffic conditions on a link to trigger events:

e Bandwidth utilization is over a threshold.
e Bandwidth utilization is under a threshold.

e Packet error rate is over a threshold.

Since a link is bidirectional, the event will be triggered when the traffic condition in either direction satisfies

the configured severity threshold.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and display the Topology Map by default.

2. Click on a link between devices in the Topology Map.
The Link Properties pane and toolbar appear when a link is selected.

@R Link Traffic ~ #X Severity Threshold B Set Port Label B Delete

3. Click Severity Threshold.
The Severity Threshold screen will appear.

Severity Threshold

Bandwidth Utilization Packet Error Rate

-
o
=
=
w0
]

Close Apply
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4. To trigger an event when the bandwidth utilization on a link exceeds a specified percentage:
a. Click the Bandwidth Utilization tab.
b. In the Over field, specify the maximum bandwidth utilization percentage.
c. From the adjacent drop-down list, select one of the following severity levels:
e Information
e Warning
e Critical
5. To trigger an event when the bandwidth utilization on a link falls below a specified percentage:
a. Click the Bandwidth Utilization tab.
b. In the Under field, specify the minimum bandwidth utilization percentage.
c. From the adjacent drop-down list, select one of the following severity levels:
e Information
e Warning
e Critical
6. To trigger an event when the packet error rate exceeds a specified percentage:
a. Click the Packet Error Rate tab.
b. In the Over field, specify the maximum bandwidth utilization percentage.
c. From the adjacent drop-down list, select one of the following severity levels:
¢ Information
e Warning
e Critical
7. Click Apply.
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Configuring Custom Port Labels

MXview uses the following port labelling convention to identify directions of traffic on a link.
<Device IP Address> / <Port Number>
You can use the Set Port Label screen to customize the port labels.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and display the Topology Map by default.

2. Click on a link between devices in the Topology Map.
The Link Properties pane and toolbar appear when a link is selected.

@B Link Traffic v ~X Severity Threshold B Sct Port Label B Delete

3. Click Set Port Label.
The Set Port Label screen appears.

Set Port Label
[J use custom Label

From: 192 1658.127 .1 / Port 26
To: 192.168.127.2 / Port 25

Close OK

Select the Use Custom Label check box.

In the From field, provide a new label for the source port.
In the To field, provide a new label for the destination port.
Click OK.

N o u ok
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Device Management

The MXview Network Topology screen provides several features and tools for managing and maintaining

devices in your network topology.

The following topics are covered in this chapter:

a
a
a
a
a
a
a
a
a
a
a
a
a
a
a
a
a
a
a
a
a
a

Viewing the Device List
Importing Device Configurations
Exporting Device Configurations

Upgrading Firmware

Generating a QR Code for the Device

Assigning a Device Model

Configuring Basic Device Information

Configuring Device IP Settings
Configuring SNMP Trap Servers
Configuring Port Settings
Configuring SNMP Settings
Configuring Polling Settings
Configuring Advanced Settings
Configuring Polling IP Settings
Changing the Device Icon
Signing on to Device Web Consoles
Pinging Devices

Changing Device Groups
Uploading Device Documents
Refreshing the Device Status
Locating Devices

Deleting Devices
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Viewing the Device List

The List view on the Network Topology screen will display a list of discovered devices in your network
topology. You can also use this view to manually add devices to your network topology or export filtered
data as a CSV file.

ALL > Site MXstudio-PC > Root

/ ey

peto fiter devices

Site Name

fte MXstudio-

fte MXstudio-

fte MXstudio-

fte MXstudio-

ite MXstudio-

Device Alias Device IP MAC Addreess.

FC 20.2021.1-ICS.67852A4;  20.20.21.1 0090EB50FBES

PC 20.2021.2-EDR 810 2020212 0090EB404A71

FC 20.2021.3-EDR 810 2020213 0090EB37F414

FC 20.20.21.4-EDRG903 2020214 0090E83018D7

PC 20.2021.5-EDRG902 2020215 0090E8365069 100.00% Device Location ,—\

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and display the Topology Map in Topology view.

2. Click

The Network Topology screen displays a list of devices on your network.

the List view (i) icon in the top right corner.

3. To add a device to your network topology:
a. Click Edit > Add Device.

T

he Add Device screen will appear.
Add Device

V1 = 161

public private

Cancel

b. Configure the following:

IP Address: Specify the IP address of the device

Assign Model: Select the model of the device

Assign To Group: Select the group to assign the device to
SNMP Version: Select the SNMP version

User Name: Specify the device login user name

Password: Create a password

Read Community: Specify the SNMP read community string
Write Community: Specify the SNMP write community string
Data Encryption: Select the data encryption method

Authentication: Select the authentication method

9-2
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e Encryption Key: Specify the encryption key
c. Click Add.
MXview adds the device to the topology.

4. To view device properties, select the check box next to the device.
The Device Properties details pane will appear.

A O

Alias

192.168.127.1--IKS-6726A

Model Name
IKS-6T26A

Mac Address
D090EB503DCE

Awailability

100.00%

System Description
IK3-6726A-2GTXSFP-T

System Object ID
1.3.6.1.4.1.8691.7.116
5. To filter the device list by severity level:

a. a. Click the Filter (<) icon in the top right corner.
The Severity drop-down list appears.

b4
| SS—

f

[4¥]
[
L]

Reset Apply
b. Select one of the following severity levels:
e Critical
e Warning
e Information

c. Click Apply.
MXview filters the device list to only display devices with the selected severity level.

6. To export the device list:

a. Click the Export (E) icon.

= (&

Export CSV

b. Select Export CSV.
c. Specify the location to save the exported file.

d. Click Save.
MXview will export the displayed data as a CSV file.
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MXview 3.1.4

Device Management

Importing Device Configurations

Use the Network Topology screen to import an INI-formatted configuration file to a device in your
network topology by selecting the device from the Topology Map or Device List.

1.

Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and displays the Topology Map by default.

Select one of the following views:

* Topology view: Displays a graphical representation of devices in your network topology.

e List view: Displays a list of the devices in your network topology.
Select the device that you want to import configurations to:
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options change.

ALL > Site THEO-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link

Navigate to Maintenance > Import Config.

The Import Config screen appears and indicates the IP address of the selected device.

Import Config - 192.168.127.1

Close

5. Click the folder (™) icon to upload the configuration file from your local machine.
6. Click Import.

MXview imports the configuration file to the specified device.
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MXview 3.1.4 Device Management

Exporting Device Configurations

Use the Network Topology screen to export an INI-formatted configuration file from a device in your
network topology by selecting the device from the Topology Map or Device List.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and display the Topology Map by default.

2. Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
3. Select the device that you want to export configurations from.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.

The toolbar options change.

ALL > Site THEQ-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

4. Navigate to Maintenance > Export Config.
The Export Config screen will appear and indicate the IP address of the selected device.

Export Config - 192.168.127.1

Close Export

Click Export.
6. Specify the location to save the configuration file.

7. Click Save.
MXview saves the device configurations as an INI file in the specified location.



MXview 3.1.4 Device Management

Upgrading Firmware

Use the Network Topology screen to upgrade the firmware (ROM-formatted file) on a device in your
network topology by selecting the device from the Topology Map or Device List.

1.

Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.

Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
Select the device that you want to upgrade the firmware for:
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options change.
ALL > Site THEO-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

Navigate to Maintenance > Upgrade Firmware.
The Upgrade Firmware screen appears and indicates the IP address of the selected device.

Upgrade Firmware - 192.168.127.1

Close

5. Click the folder (™) icon to upload the ROM-formatted firmware file from your local machine.

6. Click Upgrade firmware.

MXview will upgrade the firmware on the specified device.
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MXview 3.1.4

Device Management

Generating a QR Code for the Device

MXview allows you to generate a QR code that be can printed and attached to a field device. Use the
MXview ToGo mobile app to scan the QR code on a field device to allow field engineers to check the device
status from the mobile app.

1.

Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.

Select one of the following views:

e Topology view: Displays a graphical representation of the devices in your network topology.

e List view: Displays a list of the devices in your network topology.
Select the device that you want to upgrade the firmware for.

e Topology view: Click the icon of the device in the Topology Map.

e List view: Select the check box next to the device in the Device List.

The toolbar options will change.

ALL > Site THEQ-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link

Navigate to Maintenance -> Generate QR Code.
Specify the location to save the QR code.

Click Save.
MXview will save a zipped PNG file of the QR code to the specified location.

Print the QR code and attach it to the device.
Scan the QR code by using the MXview ToGo mobile app.

ﬂ Delete

MXview ToGo will display the device status, event list, device properties, port status, and other device

information from the MXview server.



MXview 3.1.4 Device Management

Assigning a Device Model

Use the Network Topology screen to assign a device model to a device in your network topology by
selecting the device from the Topology Map or Device List.

1.

Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.

Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
Select the device that you want to upgrade the firmware for.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options change.
ALL > Site THEO-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

Navigate to Maintenance > Assign Model.
The Assign Model screen appears.

Assign Model

IP Address - 192 168 127 1

Model - IKS-67264A

-

IK3-6726A M

Close Apply

5. Select the device model from the drop-down list.

6. Click Apply.

MXview assigns the selected model to the device.
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MXview 3.1.4 Device Management

Configuring Basic Device Information

Use the Network Topology screen to configure basic information for a device in your network topology by
selecting the device from the Topology Map or Device List.

1.

Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and display the Topology Map by default.

Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
Select the device that you want to upgrade the firmware for.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options change.
ALL > Site THEO-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

Navigate to Maintenance -> Basic Information.
The Basic Information screen appears.

Basic Information

Model

Switch Location

Close Apply
Specify the following device information:
e Model
¢ Location
e Contact
Click Apply.
MXview will update the device information.
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MXview 3.1.4 Device Management

Configuring Device IP Settings

Use the Network Topology screen to configure IP settings for a device in your network topology by
selecting the device from the Topology Map or Device List.

1. Navigate to Menu (E)—) Network 2> Topology.
The Network Topology screen appears and displays the Topology Map by default.

2. Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
3. Select the device.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.

The toolbar options change.

ALL > Site THEQ-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

4. Navigate to Maintenance > IP Configuration.
The IP Configuration screen will appear.

IP Configuration

192.168.127.3

-

R R =
255.255.255.0

s ans
O00J

ARG
Iulululu

e Nalals
0.0.0.1

Cancel Apply

5. Specify the following IP configurations:
e IP Address
¢ Netmask

e Gateway

e DNS1
e DNS2
6. Click Apply.

MXview updates the device IP configurations.
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MXview 3.1.4

Device Management

Configuring SNMP Trap Servers

MXview can collaborate with other network management software and send SNMP Traps to non-Moxa NMS.
MXview supports up to two trap servers depending on the device.

1.

Navigate to Menu (E) - Network - Topology.

The Network Topology screen will appear and display the Topology Map by default.

Select one of the following views:

e Topology view: Displays a graphical representation of the devices in your network topology.

e List view: Displays a list of the devices in your network topology.
Select the device.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options change.

ALL > Site THEO-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator
Navigate to Maintenance > Trap Server.
The Trap Server screen appears.

Trap Server

192.168.127.100

nnhli
public
Cancel Apply

Configure the following SNMP trap server settings for the device:
e Destination IP1

¢ Community Namel

e (Optional) Destination IP2

e (Optional) Community Name2

Click Apply.

G2 Add Link B Delete

MXview sends SNMP traps to the configured trap server(s) when events are detected on the device.
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MXview 3.1.4 Device Management

Configuring Port Settings

Use the Network Topology screen to configure port settings for a device in your network topology by
selecting the device from the Topology Map or Device List.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.

2. Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
3. Select the device.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options will change.
ALL > Site THEO-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

4. Navigate to Maintenance > Port Settings.
The Port Setting screen appears.

Port Setting
1 -
Enabled bt

Cancel Apply

5. Configure the following port settings for the device:
e Port: Select the port number.
e Enable: Enable or disable the port.
o Port Description: Provide a description of the port.
e Port Name: Provide a custom name for the port.

e Apply settings to another port: Select to apply the configured settings to other ports on the
device.

6. Click Apply.
MXview will update the port settings to the device.
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MXview 3.1.4 Device Management

Configuring SNMP Settings

Use the Network Topology screen to configure SNMP settings for a device in your network topology by

selecting the device from the Topology Map or Device List.

1.

Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.

Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
Select the device.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options will change.
ALL > Site THEO-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

Navigate to Maintenance > SNMP Settings.
The SNMP Configuration screen will appear.

Add Device

public private

Cancel

Configure the following SNMP settings for the device:
e SNMP Version

e User Name

e Password

¢ Read Community

e Write Community

o Data Encryption

e Authentication

e Encryption Key

e Encryption Protocol

e SNMP Port

Click Apply.

MXview updates the port settings to the device.
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MXview 3.1.4

Device Management

Configuring Polling Settings

Use the Network Topology screen to configure ICMP or SNMP polling settings for a device in your network
topology by selecting the device from the Topology Map or Device List.

1.

Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and display the Topology Map by default.

Select one of the following views:

e Topology view: Displays a graphical representation of the devices in your network topology.

e List view: Displays a list of the devices in your network topology.
Select the device.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options change.

ALL > Site THEO-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link

Navigate to Maintenance > Polling Settings.
The Polling Settings screen appears.

Polling Settings

10 =

Configure the following polling settings for the device:

e ICMP polling interval

e Consecutive failure to trigger ICMP unreachable event
e SNMP polling interval

¢ Consecutive failure to trigger SNMP unreachable event
Click Apply.

MXview will update the polling settings for the device.
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MXview 3.1.4 Device Management

Configuring Advanced Settings

Use the Network Topology screen to configure advanced settings for a device in your network topology by
selecting the device from the Topology Map or Device List.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and display the Topology Map by default.

2. Select one of the following views:
a. Topology view: Displays a graphical representation of the devices in your network topology.
b. List view: Displays a list of the devices in your network topology.
3. Select the device.
a. Topology view: Click the icon of the device in the Topology Map.
b. List view: Select the check box next to the device in the Device List.

The toolbar options change.

ALL > Site THEQ-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

4. Navigate to Maintenance > Advanced Settings.
The Device Settings screen appears.

Device Setting

[] Modify Device Alias

20.20.27.3-EDS-510A

+ Use Global Access User Name and Password

Cance‘ m

5. To modify device alias:
a. Select the Modify Device Alias check box.
b. Edit the Alias field.
6. To specify login credentials for the device web console (if different from the global MXview credentials):
a. Clear the Use Global Access User Name and Password check box.
b. Enter the User Name and Password for the device web console.

7. Click Apply.
MXview updates the device settings.
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MXview 3.1.4 Device Management

Configuring Polling IP Settings

Use the Network Typology screen to configure the IP address used to poll a device in your network
topology by selecting the device from the Topology Map or Device List.

1. Navigate to Menu (E) - Network -> Topology.
The Network Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
3. Select the device.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options will change.
ALL > Site THEO-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete
4. Navigate to Maintenance -> Polling IP.
The Polling IP screen will appear.

Palling IP

Cancel Apply

5. Select the IP address used to poll the device.

6. Click Apply.
MXview will update the polling IP address for the device.
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MXview 3.1.4 Device Management

Changing the Device Icon

Use the Network Topology screen to change the device icon by selecting the device from the Topology
Map or Device List, and then upload a JPG, GIF, or PNG image file.

1. Navigate to Menu (E) - Network -> Topology.
The Network Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
3. Select the device.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options will change.
ALL > Site THEO-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

4. Navigate to Maintenance > Change Device Icon.
The Change Device Icon screen appears.

Change Device Icon

IP Address : 192.168.127 1
Madel lcon

Cancel Apply

5. Click the folder (™) icon to upload the device icon from your local machine.

6. Click Apply.
MXview will change the device icon to the uploaded JPG, GIF, or PNG image file.
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MXview 3.1.4 Device Management

Signing on to Device Web Consoles

MXview allows you to use the Network Topology screen to the web console for a device from the
Topology Map or Device List.

NOTE

You can use the Preferences screen to configure the web console protocol. The web console protocol can
be set to HTTP or HTTPS, and then the port humbers of the HTTP and HTTPS can be set by users. In
addition, the Telnet port can be set as well.

1. (Optional) Configure the web console protocol:

a. Navigate to Menu (E) - Preferences.
The Preferences screen appears.

b. In the Advanced section, expand Management Interface.
The Management Interface settings appear.

Advanced

System Configuration v
Device v
SNMP Configuration v
Events v
Management Interface =
Ht-'.|: - hd

443
23

c. Configure the following:
¢ Web Console Protocol
e HTTP Port
e HTTPS Port
e Telnet Port

d. Click Save.
MXview updates the web console protocol settings.

2. Navigate to Menu (E) - Network > Topology.

The Network Topology screen will appear and display the Topology Map by default.

3. Select one of the following views:

e Topology view: Displays a graphical representation of the devices in your network topology.

e List view: Displays a list of the devices in your network topology.

4. Select the device.

¢ Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.

The toolbar options change.

ALL > Site THEO-LAIO1 > Root »?

R Maintenance v R Tools v # Change Group . Document C' Refresh 9 Locator &> Add Link B Delete

5. Navigate to Tools > Web Console.

The login screen for device web console appears in a new browser tab.
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MXview 3.1.4 Device Management

NOTE You may need to allow pop-ups on your web browser in order to view the device web console.

6.
7.

Enter the Username and Password for the device web console.

Click Login.
The device web console will successfully log in.

Pinging Devices

Use the Network Topology screen to ping devices in your network topology from the Topology Map or

Device List.

1.

Navigate to Menu (E) - Network - Topology.
The Network Topology screen will appear and display the Topology Map by default.

Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
Select the device.
e Topology view: Click the icon of the device in the Topology Map.
o List view: Select the check box next to the device in the Device List.
The toolbar options change.
ALL > site THEO-LAIO1 > Root >

* Maintenance v R Tools v /‘ Change Group . Document C' Refresh q Locator G2 Add Link E Delete

Navigate to Tools > Ping.
The Ping screen will appear and will start the ping test.

Ping 192.168.127.1

Pinging 192.168.127_1 with 32 bytes of data:

Reply from 192_168.127_1: bytes=32 time=1ms TTL=64
Reply from 192.168.127_1: bytes=32 time=1ms TTL=64
Reply from 192.168.127_1: bytes=32 time=1ms TTL=64
Reply from 192.168.127_1: bytes=32 timg=2ms TTL=64

Ping statistics for 192.168.127_1:
Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:
Minimum = 1ms, Maximum = 2ms, Average = 1ms

Close

5. Wait for the ping test to finish and view the results.
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MXview 3.1.4 Device Management

Changing Device Groups

Use the Network Topology screen to change the assigned group for a device by selecting the device from

the Topology Map or Device List.

1.

Navigate to Menu (E) - Network > Topology.
The Network Topology screen will appear and display the Topology Map by default.

Select one of the following views:

e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.

Select the device.

e Topology view: Click the icon of the device in the Topology Map.

e List view: Select the check box next to the device in the Device List.

The toolbar options change.

ALL > Site THEQ-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

Click Change Group.
The Change Group screen will appear and displays the following information:

Change Group

Root h
IP Address
v 1921681271
192.168.127.2
192.168.127.3
192.168.127.4
Group1 v
Cancel Apply

(Optional) Select additional IP addresses to assign other devices from the current group to the new
group.

From the Assign to Group drop-down list, select the new group that you want to assign the selected
device(s) to.

Click Apply.

MXview will assign the selected device(s) to the new group.
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MXview 3.1.4 Device Management

Uploading Device Documents

Use the Network Topology screen to upload PDF documentation (e.g., user’s manual, quick installation
guide) for a device. Uploaded documents can be downloaded for future reference.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.
2. Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
3. Select the device.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options will change.
ALL > Site THEO-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

4. Click Document.
The Set Document screen will appears.

Set Document - 192.168.127.1

Close

5. Click the folder (™) icon to upload a PDF document from your local machine.

6. Click Set Document.
MXview uploads the PDF document for the device.
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MXview 3.1.4 Device Management

Refreshing the Device Status

Since some device data is collected by polling, there may be a time delay for some data. Use the Network
Topology screen to refresh the device status by selecting the device from the Topology Map or Device
List.

1. Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.

2. Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
3. Select the device.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.

The toolbar options change.

ALL > Site THEQ-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

4. Click Refresh.
MXview polls the device for updated data.

Locating Devices

Use the Device Locator to locate a device in the field. When the Device Locator is activated, all the LEDs
on the device start blinking to help you locate the device.

1. Navigate to Menu (B) > Network > Topology.
The Network Topology screen appears and will display the Topology Map by default.
2. Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
3. Select the device.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options will change.
ALL > Site THEO-LAIO1 > Root >

R Maintenance v R Tools v # Change Group . Document C' Refresh Q Locator G2 Add Link B Delete
4. Click Locator.
The Device Locator screen appears.

Device Locator

P Start W Stop

Close

5. Click Start.
All the LEDs on the device start blinking.

6. After you have located the device, click Stop.
All the LEDs on the device stop blinking.
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Deleting Devices

Use the Network Topology screen to delete devices from the Topology Map. After a device is deleted, it
will be removed from the topology map and scan range, and the device will not be polled.

1.

Navigate to Menu (E) - Network > Topology.
The Network Topology screen appears and displays the Topology Map by default.

Select one of the following views:
e Topology view: Displays a graphical representation of the devices in your network topology.
e List view: Displays a list of the devices in your network topology.
Select the device.
e Topology view: Click the icon of the device in the Topology Map.
e List view: Select the check box next to the device in the Device List.
The toolbar options will change.
ALL > Site THEO-LAIO1 > Root >

* Maintenance v ‘)\ Tools v /‘ Change Group - Document C' Refresh Q Locator G2 Add Link ﬂ Delete

Click Delete.
MXview removes the device from your network topology.
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10

Events and Notifications

MXview allows you to monitor system events, create custom monitoring events, and configure event

notifications.

The following topics are covered in this chapter:

O Event Monitoring

>
>
»
>

Viewing All Events
Viewing Syslog Events
Configuring the Server Disk Space Threshold

Configuring Event Thresholds and Severity Levels

O Notification Methods

>
>
>
>

Configuring Email Server Settings

Configuring SMS Notification Settings

Configuring SNMP Trap Destinations for the MXview Server
Configuring the SNMP Trap Destination for Devices

O Notification Management

>
>
>

Configuring New Event Notifications
Editing or Exporting Registered Actions

Editing or Exporting Notification Configurations

O Custom Event Management

>
>
>

Configuring Custom Events
Viewing or Exporting Custom Event Settings

Enabling/Disabling or Editing Custom Events



MXview 3.1.4 Events and Notifications

Event Monitoring

Viewing All Events

The All Events screen provides information about all the network events for devices in your topology. Use
the filters to customize the information displayed in the table. You can also export the data as a CSV file.

All Events

er event
Ack  Site Name

Site MXstudio-PC

Site MXstudio-PC

Site MXstudio-PC

Site MXstudio-PC

Site MXstudio-PC

Site MXstudio-PC

404

403

402

401

400

399

Source

Mxview

Mxview

MXview

Mxview

Mxview

Mxview

Source IP

127.0.0.1

20.2021.2

20.2021.2

2020222

0000

0000

Device Alias

20.20.21.2-EDR-810

20.20.21.2-EDR-810

20.20.22.2-PT-G503

1. Navigate to Menu (E) - Event > All Events.
The All Events screen will display the following information in a table format:

Description

User login: admin

Secure router under
firewall attack

Secure router under
DDoS attack

Device SNMP
unreachable

MXview server is
started

Auto Topology
finished

Time Issued

2019-02-26 09:21:57

2019-02-26 09:21:42

2019-02-26 09:21:42

2019-02-26 09:21:41

2019-02-26 09:21:11

2019-02-26 08:41:18

Column Description

Ack Acknowledge status of the event

Site Name The site to which the device that issued the event belongs
ID The unique identifier of the event

Source IP The IP address of the device that issued the event

Device Alias The unique name of the device

Description The description of the event

Time Issued The time the event was issued

2. To filter the information in the table, type a full or partial string that matches the value in any of the

table columns.
MXview filters the table to only display results that fully or partially match the specified string.

3. To filter the information
a. Click the Filter (=)

icon in the top right corner.

The following screen will appear.

[¥]
3]

in the table by specific criteria:

Start Date B Hou - e - e d
End Date B Hou - e * Se d

Resst
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b. Specify any of the following criteria:

Criteria Description

Severity Select the severity level of the event

Site Name Select the site to which the device that issued the event belongs
Group Select the group to which the device is assigned

IP Address Specify the IP address of the device

Source Select the source of the event

Ack Select the acknowledgement status of the event

Start Date Specify the start date and time for the event data to display

End Date Specify the end date and time for the event data to display

c. Click Apply.
MXview filters the table to only display events that match the specified criteria.
4. To sort the data in the table by a specific column, click the column heading.
MXview sorts the table by the column.
5. To export data displayed on the All Events screen:
a. Click the Export (E) icon.

= &

Export CSV

b. Select Export CSV.
c. Specify the location to save the exported file.

d. Click Save.
MXview exports the displayed event data as a CSV file.

Viewing Syslog Events

The Syslog Event Viewer screen provides information about the syslog events on your network. Use the
filters to customize the information displayed in the table. You can also export the data as a CSV file.

Syslog Event Viewer

Site Name Severity Time Stamp IP Address Facility Message

1. Enable the built-in syslog server.
a. Navigate to Menu (E) - Preferences.
The Preferences screen appears.

b. In the Server section, expand Syslog Server Configuration.
The Syslog Server Configuration settings will appear.

Server
Syslog Server Configuration L

Disabled -

10-3



MXview 3.1.4 Events and Notifications

c. Select Enabled from the Enable built-in syslog server drop-down list.
d. Specify the syslog server communication port.
e. Click Save.
MXview enables the built-in syslog server and starts logging syslog events.

2. Navigate to Menu (E) > Event > Syslog Viewer.
The Syslog Event Viewer screen displays the following information in a table format:

Column Description

Ack The acknowledgement status of the event

Site Name The site to which the device that issued the event belongs
ID The unique identifier of the event

Source IP The IP address of the device that issued the event

Device Alias The unique name of the device that issued the event
Description The description of the event

Time Issued The time the event was issued

3. To filter the information in the table, type a full or partial string that matches the value in any of the
table columns.
MXview filters the table to only display results that fully or partially match the specified string.
4. To filter the information in the table by specific criteria:
a. Click the Filter (=) icon in the top right corner.
The following screen will appear.

Site ame - B A a ><
Higherth... ¥ Seve v
Start Date @ Ho b e -
End Date B Ho - e v
Reset Apply
b. Specify any of the following criteria:
Criteria Description
Site Name Select the site to which the device that issued the event belongs
IP Address Specify the IP address of the device that issued the event
Facility Select the group to which the device is assigned
Priority Select the criteria operator for matching the event severity level:

e Higher than or equal to
e Equals

e Lower than or equal to

Severity Select the severity level of the event
Start Date Specify the start date and time for the event data to display
End Date Specify the end date and time for the event data to display

c. Click Apply.
MXview filters the table to only display events that match the specified criteria.

5. To sort the data in the table by a specific column, click the column heading.
MXview sorts the table by the column.
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6. To export data displayed on the All Events screen:

Configuring the Server Disk Space Threshold

a. Click the Export (E]) icon.

= |

Export CSV

b. Select Export CSV.
c. Specify the location to save the exported file.

d. Click Save.
MXview exports the displayed event data as a CSV file.

MXview allows you to trigger an event notification when the MXview server reaches a configured disk space
threshold.

1.

4.

Navigate to Menu (E) - Preferences.

The Preferences screen appears.

In the Advanced section, expand System Configuration.
The System Configuration settings will appear.

In the Threshold of Disk Space (MB) field, specify the threshold for available disk space remaining on

the MXview server in MB.
Advanced

System Configuration

Disabled -

Click Save.

MXview will trigger an event when the threshold for the available disk space remaining is reached.

Configuring Event Thresholds and Severity Levels

Use the Preferences screen to configure default event thresholds and severity levels.

1.

Navigate to Menu (E) - Preferences.

The Preferences screen will appear.

In the Advanced section, expand Events.

The Events settings will appear.

Select one of the following severity levels for Link Up events:
¢ Information

e Warning

e Critical

Select one of the following severity levels for Link Down events:

e Information
e Warning

e Critical

10-5



MXview 3.1.4 Events and Notifications

5. To trigger events when network bandwidth utilization exceeds a threshold:
a. Select Enabled from the first Bandwidth Utilization Over drop-down list.

Bandwdth Utilization Uver

Enabled -

ExamarWig URIIZaton e SEE

] Waming -

b. Specify the percentage of bandwidth utilization for the threshold.

Bandwdth Utilization Ower

Enabled v

0 WWaming o

c. Select the Severity level for the event.

6. To trigger events when network bandwidth utilization falls below a threshold:
a. Select Enabled from the first Bandwidth Utilization Under drop-down list.

Bandwadth Utiizabion Uinder

Enabled -

ExamarWig LRNIZaton Linge: Ve

] Waming -

b. Specify the percentage of bandwidth utilization for the threshold.

Bandwadth Utilizabion Under

Enabled b

B arCrsiC LITHNZ3E0n Linoe B2

] Waming -

c. Select the Severity level for the event.

7. To trigger events when the packet error rate exceeds a threshold:
a. Select Enabled from the first Packet Error Rate Over drop-down list.

Packet Emor Hate Cher
Enabled A
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b. Specify the packet error rate (in percent) for the threshold.

Packet Emror Rate Owver
Enabled L
0 Waming A

c. Select the Severity level for the event.

8. To trigger events when device availability falls below a certain threshold:
a. Select Enabled from the first Availability Under drop-down list.

Availabiity Under

Enabled -

95 Waming -

b. Specify the device availability level (in percent) for the threshold.

Avalabiity Under

Enabled -

95 Waming -

c. Select the Severity level for the event.

9. Click Save.
MXview will update the event settings.

Notification Methods

MXview supports email, and SNMP trap notifications for events. Each notification method requires specific
server configurations.

Configuring Email Server Settings

Use the Preferences screen to configure an email server to send email notifications for event notifications.

1. Navigate to Menu (E) - Preferences.
The Preferences screen will appear.
2. In the Server section, expand Email Sever Setup.
The Email Server Setup settings will appear.
3. Configure the following:
e Server Domain Name/IP
e Port number
e Encryption
e Username
e Password
e Sender Address

4. Click Save.
MXview can send email messages for configured event notifications.
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Configuring SNMP Trap Destinations for the MXview Server

Use the Preferences screen to configure the SNMP trap destination(s) for the MXview server.

1.

Navigate to Menu (E) - Preferences.

The Preferences screen appears.

In the Server section, expand SNMP Server of MXview.
The SNMP Server of MXview settings will appear.

Configure the following:

SNMP Version

IP Address of Trap Server 1
Community of Trap Server 1
IP Address of Trap Server 2

Community of Trap Server 2

Click Save.

Configuring the SNMP Trap Destination for Devices

By using the MXview server as a trap destination of a device, events associated with the device will be sent

to the server in real time, and can be seen by remote clients.

1.

Navigate to Menu (E) - Preferences.

The Preferences screen will appear.

In the Server section, expand SNMP Server of Device.
The SNMP Server of Device settings will appear.

Configure the following:

Destination IP1: Specify the IP address of the MXview server

Community Name1: Specify the community string of the MXview server

Click Save.
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Notification Management

The Notification Management screen allows you to configure event notifications by issuing a registered
action (e.g., sending an email message to a specified recipient) when configured events are detected on

your network.

Notification Management

Noification Name Type Registered devices Registered Actions

Configuring New Event Notifications

MXview event notifications require at least one registered action (e.g., sending an email message to a
specified recipient), which MXview performs when a specified event is detected on your network.

1. Navigate to Menu (E) > Event > Notification Management.
The Notification Management screen appears.
2. To register an action:
a. Click the Action tab.
The Action tab displays a list of registered actions (if any).

Notification Management

Action Name Type Action Information

S W Test E-mail email@example.com

b. Click the Add () icon in the top right corner.
The Add notification action screen will appear.

Add notification action

Cancel

c. In the Action Name field, type a name to describe the action.

d. From the Type drop-down list, select one of the following actions:
e E-mail: Sends an email message to the specified email address
¢ Sound File: Plays the uploaded sound file
¢ Message Box: Displays a message box when the event occurs

e SNMP Trap: Sends an SNMP trap
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e. Provide additional information required for the action (if any).
f. Click Apply.
The registered action appears in the table on the Action tab.

3. To add a new event notification:
a. Click the Notification tab.
The Notification tab displays a list of configured event notifications (if any).

Notification Management

Noification Name Type Registered devices Registered Actions

S B Test Device ICMP unreachable 4 Test

/s 0 1= Port Link Down 4 123

b. Click the Add () icon in the top right corner.
The Add notification screen appears.

Add notification

o
m
[

o
m
[

Cancel

In the Notification Name field, type a name to describe the event notification.

a o

From the Type drop-down list, select the event type.

e. From the Registered devices drop-down list, select the network device(s) you want to monitor.

f. From the Registered Actions drop-down list, select the action that MXview performs when the
specified event is detected on the previously selected device(s).
g. Click Apply.

The event notification appears in the table on the Notification tab.
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Editing or Exporting Registered Actions

Use the Action tab on the Notification Management screen to edit registered actions or export a CSV file

containing registered action information.

1.

Navigate to Menu (E) -> Event > Notification Management.

The Notification Management screen will appear.

Click the Action tab.

The Action tab displays a list of registered actions.

To edit a registered action:

a. Click the Edit (#") icon next to the action you want to edit.
The Edit notification action screen will appear.

Edit notification action

Action Name

Test

E-mail h
email@example.com

Cancel

b. Modify the following settings:
e Action Name
¢ Type
e Action information

c. Click Apply.
The Action tab appears and displays the updated action information.

To export data displayed on the Action tab:
a. Click the Export (E]) icon.

= &

Export CSV

b. Select Export CSV.
c. Specify the location to save the exported file.

d. Click Save.
MXview exports the displayed event data as a CSV file.
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Editing or Exporting Notification Configurations

Use the Notification tab on the Notification Management screen to edit configured notifications or

export a CSV file containing notification configuration information.

1.

2. Click the Notification tab.

The Notification tab displays a list of configured notifications.

3. To edit a notification:

a. Click the Edit (#") icon next to the action you want to edit.

The Edit notification screen will appear.

Edit notification

Test

Device ICMP unreachable

Test

b. Modify the following settings:
¢ Notification Name
e Type
o Registered devices
* Registered Actions

c. Click Apply.

5]
=]
i
[

Cancel

Navigate to Menu (E) -> Event > Notification Management.
The Notification Management screen will appear.

Apply

The Notification tab appears and displays the updated notification information.

4. To export data displayed on the Action tab:

a. Click the Export (E) icon.

= |G

Export CSV

b. Select Export CSV.

c. Specify the location to save the exported file.

d. Click Save.

MXview exports the displayed event data as a CSV file.
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Custom Event Management

The Custom Events screen provides information about all the custom events configured on MXview. You
can use the Custom Events screen to view whether a custom event is enabled or disabled, modify a
custom event, or export custom event configurations as a CSV file.

Custom Events
m Type to filter custom events &

Critical (0)
I Event Name Enabled/Disabled Condition Description Recovery Description Duration Register devices

Waming (1) -
7 [ ] IpAddr Enabled Equal 1.234 1] 4

I Information (0)

Configuring Custom Events

The Custom Events screen allows you to define your own events to monitor with flexible detection
thresholds, severity levels, and duration times. You can also export the custom event configurations as a
CSV file.

Custom Events

All )

[ +]

Critical (0)
I Event Name Enabled/Disabled Condition Description Recovery Description  Duration Register devices

Waming (0)

I Information (0)

1. Navigate to Menu (E) - Event - Custom Events Management.
The Custom Events screen appears.

2. Click the Add () button in the upper-right corner of the screen.
The Add custom event screen will appear.

Add custom event

Enabled -

0

Cancel
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3. Select the default event status:
e Enabled: MXview monitors the event

e Disabled: MXview does not monitor the event
4. Select one of the following severity levels for the event:
¢ Information
e Critical
e Warning
e System Information

5. Click the Device Properties and select the device property to monitor.
Configure the following threshold criteria:
e Condition operator: Select the criteria operator for matching the condition value
e Condition value: Specify the value for the criteria operator to match
7. (Optional) In the Description field, type a string (up to 250 characters in length) to describe the custom
monitoring.
8. (Optional) In the Recovery Description field, type a string (up to 250 characters in length) to describe
how to recover from the event.
9. In the Duration field, specify the number of consecutive pollings for the event.
10. From the Register Devices drop-down list, select the devices to monitor for the custom event.
11. Click Apply.
The custom event appears in the table on the Notification tab.

Viewing or Exporting Custom Event Settings

The Custom Events screen provides information about all the custom events configured on MXview. You
can use the Custom Events screen to view whether a custom event is enabled or disabled, modify a
custom event, or export custom event configurations as a CSV file.

Custom Events

Al (1)
Type fo filter custom events &)

Critical (0)
I Event Name Enabled/Disabled Condition Description Recovery Description  Duration Register devices

Waning (1) _
J IpAddr Enabled Equal 1234 0 4
s 0

I Information (0)

1. Navigate to Menu (E) - Event > Custom Events Management.
The Custom Events screen will appear and displays the following information in a table format:

Column Description

Event Name The name of the event

Enabled/Disabled The monitoring status of the event

Condition The threshold criteria configured for the event

Description The description of the event

Recovery Description The recovery description of the event

Duration The number of consecutive pollings for the event
Registered Devices The number or registered devices that the event applies to

2. To filter the information in the table, type a full or partial string that matches the value in any of the
table columns.
MXview filters the table to only display events with values that fully or partially match the specified
string.
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3. To filter the information in the table by event severity, click one of the color-coded severity levels in the
left-side panel.

All (D)

Critical (0)
Waming (0)
Information {0}

MXview filters the table to only display events that match the selected severity level.
4. To sort the data in the table by a specific column, click the column heading.

MXview sorts the table by the column.
5. To export data displayed on the All Events screen:

a. Click the Export (@) icon.

= &

Export CSV

b. Select Export CSV.
c. Specify the location to save the exported file.

d. Click Save.
MXview exports the displayed event data as a CSV file.
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Enabling/Disabling or Editing Custom Events

To enable or disable a custom event, edit the custom event settings.

1. Navigate to Menu (E) - Event - Custom Events Management.
The Custom Events screen appears.

2. Click the Edit (#') icon next to the event you want to enable/disable.
The Update custom event screen appears.

Update custom event

nable Custom Event
Enabled N

warning v
IpAddr
Equal ¥ 1234

0

Cancel Apply
3. From the Enable Custom Event drop-down list, select one of the following:
e Enabled
e Disabled
Modify any additional event settings you wish to change.

5. Click Apply.
The Custom Events screen will appear and displays the updated event information.
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Reports

MXview provides reports that summarize key information about your VLAN configuration, network devices,
and device availability.

The following topics are covered in this chapter:

O Viewing VLAN Reports
O Viewing Inventory Reports

O Viewing Availability Reports



MXview 3.1.4 Reports

Viewing VLAN Reports

Use the VLAN report screen to view information about the VLAN configuration on your network. You can
also export the report as a CSV file or a PDF file.

VLAN

Sfe Kamw D P Madel VLAN 1D Aooeus Ports Trask Porfs Hybrid Forty Maragpamen? VAN

1. Navigate to Menu (B) > Reports > VLAN Report.
The VLAN report screen will appear and display the following information in a table format:

Column Description

Site Name The site that the VLAN device belongs to
Device IP The IP address of the VLAN device

Model The model nhumber of the VLAN device
VLAN ID The VLAN ID of the device

Access Ports The access ports on the VLAN device

Trunk Ports The trunk ports on the VLAN device
Management VLAN The management status of the VLAN device
Hybrid Ports The hybrid ports on the VLAN device

2. To filter the information in the table, type a full or partial string that matches the value in any of the
table columns.
MXview filters the table to only display results that fully or partially match the specified string.

3. To sort the data in the table by a specific column, click the column heading.
MXview sorts the table by the column.

4. To export the report data:
a. Click the Export (E) icon.
Select one of the following report formats:
e Export CSV
e Export PDF
c. Specify the location to save the exported file.

d. Click Save.
MXview exports the report data in the selected format.
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Viewing Inventory Reports

Use the Inventory Report screen to view information about the devices on your network.

export the report as a CSV file or a PDF file.

Inventory Report

Type to filter inventory report

Site Name

Site THEO-LAIO1

Site THEO-LAIO1

Site THEO-LAIO1

Site THEO-LAIOT

IP Address

192.168.127 1

192.168.127.2

192.168.127.3

192.168.127.4

Alias

192.168.127 1--1KS-6726A

192 168.127 2--IKS-B6728A-
8POE

192 168.127 3--EDS-G516E

192.168.127.4--EDS-G516E

Model

IKS-6726A

IKS-6728A-8POE

EDS-G516E

EDS-G516E

MAC Address

0090E8503DC6

0090E8097885

0090E8090909

0090E8301F42

1. Navigate to Menu (E) - Reports > Inventory Report.
The Inventory Report screen appears and displays the following information in a table format:

You can also

System Description
IKS-6726A-2GTXSFP-T

IKS-8728A-8POE-
4GTXSFP-T

EDS-G516E

EDS-G516E

Column

Description

Site Name

The site that the device belongs to

IP Address

The IP address of the device

Alias

The unique name of the device

Model

The model number of the device

MAC Address

The MAC address of the device

System Description

The description of the device

2. To filter the information in the table, type a full or partial string that matches the value in any of the

table columns.

MXview filters the table to only display results that fully or partially match the specified string.

3. To sort the data in the table by a specific column, click the column heading.

MXview sorts the table by the column.

4. To export the report data:
Click the Export (E ) icon.

Select one of the following report formats:
e Export CSV
e Export PDF

c. Specify the location to save the exported file.

d. Click Save.

MXview exports the report data in the selected format.
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Viewing Availability Reports

Use the Availability Report screen to view information about the device availability on your network. You
can also export the report as a CSV file or a PDF file.

Availability Report

= @

Site Name Device Alias Start date End date Average Availability Worst Availability Days
Site THEO-LAIDY 192 168 127 1-IKS-6726A 2018-11-28 2018-11-28 1
Site THEO-LAID 192.168.127.2-IKS-6728A-  2018-11-28 2018-11-28 100% 100% 1

8POE
Site THEO-LAIDY 192 168 127 3-EDS- 2018-11-28 2018-11-28 1

G516E
Site THEO-LAID1 192.168.127.4-EDS- 2018-11-28 2018-11-28 100% 100% 1

G516E

1. Navigate to Menu (E) - Reports > Availability Report.
The Availability Report screen appears and displays the following information in a table format:

Column Description

Site Name The site that the device belongs to

Device Alias The unique name of the device

Start Date The start date for the device availability report

End Date The end date for the device availability report

Average Availability The average device availability from the start date to the end date
Worst Availability The worst device availability from the start date to the end date
Days The number of days used to calculate device availability

2. To filter the information in the table, type a full or partial string that matches the value in any of the
table columns.

MXview filters the table to only display results that fully or partially match the specified string.

3. To change the date range for the report:

a. Click the Filter (=) icon in the top right corner.
The Query Date screen appears.

Query Date

Start Date

Cancel

b. Select the Start Date.
Select the End Date.
d. Click Apply.
MXview filters the table to only display device availability for the specified data range.

4. To sort the data in the table by a specific column, click the column heading.
MXview will sort the table by the column.
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5. To export the report data:
Click the Export (E) icon.
Select one of the following report formats:
¢ Export CSV
e Export PDF
c. Specify the location to save the exported file.

d. Click Save.
MXview will export the report data in the selected format.

11-5



12

Backups and Migrations

The MXview web console provides several features to assist database backups and device configuration
migrations. MXview allows you to back up or restore configurations for multiple devices, and also compare
changes between different versions of archived configuration files. You can also create scheduled jobs to
automatically export/import device configurations or back up the MXview database.

The following topics are covered in this chapter:

Backing Up the MXview Database

Backing Up Device Configurations

Restoring Device Configurations

Archiving Device Configurations to the MXview Server

Comparing Archived Configuration Files

QaoaaaoaaQ

Creating Scheduled Jobs for Database/Configuration Backups
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Backing Up the MXview Database

Use the Database Backup screen to back up the MXview database and configuration files.

1. Navigate to Menu (E) - Migrations > Database Backup.
The Database Backup screen appears.

2. In the Name field, specify the directory to where MXview exports the database backup and configuration
files.
Default directory: %MXviewPro_Data%\db_backup

3. Click Apply.
A popup message appears indicating that the database has been backed up.

Backing Up Device Configurations

Use the Configuration Center screen to export configuration backup files from one or more devices.

1. Navigate to Menu (E) - Migrations > Configuration Center.

The Configuration Center screen appears.

2. Click the Backup tab.
Available devices will appear in the Device List.

Configuration Center

m
)
=
L
T
T
1
T

Device List

E =
IP Address Alias Name GFOUp
% | IKS BT26A Root
a ~IKS-5728A-8POE Root
B ~EDS-GS16E Root
% | | EDS-G516E Root

3. (Optional) To filter the devices in the Device List:
a. Click the Filter (=) icon.
b. Specify any of the following criteria:
e Group: The group in the MXview tree structure that the device is assigned to
e IP Address: The IP address of the device

c. Click Apply.
MXview filters the Device List according to the specified criteria.

4. To back up configurations from all available devices:

a. Click the Export (@) icon.

&l =

Export C5V

b. Select Export CSV.
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c. Specify the location to save the configuration file.

d. Click Save.
MXview exports configurations from all available devices as a CSV file.

5. To back up configurations from specific devices:

a. Select the check box next to the device(s) you want to back up.
b. Click the Save (B) icon in either of the following locations:
e For a single device, click the Save (B) next to the selected device.
e For multiple devices, click the Save (a) icon in the upper right corner of the screen.

The Backup Configuration screen appears.

Device List

IP Address Alias Name Group

Backup Configuration

System will archive these configuration files

192.168.127.2 192.1
5]

a 192.168.127.120 192.1
P510A
508A

c. Click Apply.
MXview archives configuration files from selected device(s) to the MXview server.

For more information, see the following topics:
e Archiving Device Configurations to the MXview Server

e Comparing Archived Configuration Files

d. Specify the location to save the exported configuration backup file.

e. Click Save.
MXview will export configurations from the selected device(s) as a ZIP file.

Restoring Device Configurations

Use the Configuration Center screen to restore configurations to one or more devices by restoring an
archived configuration from the MXview server or importing a local configuration backup file (in INI format).

NOTE

Restoring archived device configurations requires archiving device configurations to the MXview server.
For more information, see Archiving Device Configurations to the MXview Server.

1. Navigate to Menu (E) - Migrations > Configuration Center.
The Configuration Center screen will appear.

2. Click the Restore tab.

Available devices will appear in the Device List.

Configuration Center

Device List

E =
1P Address Alias Name Group
E 192.168.127 1 192168127 1-IKS-6726A Root
E 192.168.127.2 192 168.127 2-IKS-6728A-8POE Root
E 192.168.127.3 192.168.127.3-EDS-GH16E Root
E 192.168.127.4 192.168.127.4-EDS-G516E Root
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3.

4.

5. To restore an archived configuration file to a device:

(Optional) To filter the devices in the Device List:
a. Click the Filter (<) icon.
b. Specify any of the following criteria:

e Group: The group that the device is assigned to

e IP Address: The IP address of the device
c. Click Apply.

MXview filters the Device List according to the specified criteria.

(Optional) To export configurations from all available devices:

a. Click the Export (@) icon.

=

Export CSV

b. Select Export CSV.

MXview exports configurations from all devices as a CSV file.

a. Click the Import (E) icon next to the IP Address of a device in the Device List.

The Restore Configuration screen will appear.

Restore Configuration

Restore Device - 192.168.127 27

Restore Configuration v

Cancel Apply

b. From the Restore Configuration drop-down list, se

lect the archived device configuration to restore.

Restore Configuration

Local File
192 168.127 1_20181124_1752.ini
192 168.127.2_20181124_1810.ini

192.168.127.3_20181124_2218.ini Apply

‘ 192.166.127.4_20181124_2218.ini P

12-4



MXview 3.1.4 Backups and Migrations

c. Click Apply.

Restore Configuration

Restore Device - 192.168.127 1

Restore Configuration

192.168.127.1_20181124_17... ~

Createing Time: 2018-11-24 17:52:00
Last Checking Time: 2018-11-25 16:16:00

Cancel Apply

MXview imports the configuration file to the selected device.
6. To import a local configuration file to a device:

a. Click the Import (E) icon next to the IP Address of a device in the Device List.
The Restore Configuration screen appears.

Restore Configuration

Restore Device - 192.168.127 27

Restore Configuration v

Cancel Apply

b. From the Restore Configuration drop-down list, select Local File.

c. Click Configuration File field to a select the configuration file.

Restore Configuration

Restore Device - 192.168.127.27

Restore Configuration

Local File v

Configuration File O

Cancel Apply

d. Select the configuration file to import and click Open.

e. Click Apply.

Restore Configuration

Restore Device - 192,168 .127.3

estore Lonnguration

Local File -

Configuration File

192 168.127.3.0ni [}

Cancel Apply

MXview imports the configuration file to the selected device.
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Archiving Device Configurations to the MXview
Server

Archiving configuration backup files to the MXview server allows you to restore the archived device
configurations from the MXview server without manually importing a local configuration file. You can also
compare changes between different versions of the archived configuration backup file.

1. Navigate to Menu (E) - Migrations > Configuration Center.
The Configuration Center screen will appear.

2. Click the Backup tab.
Available devices appear in the Device List.

3. Select the check box next to the device(s) you want to archive.

4. Click the Save (a) icon in the upper right corner of the screen.
The Backup Configuration screen appears.

Device List

IP Address Alias Name Group

Backup Configuration

System will archive these configuration files

a 192.168.127.120 192.1i
P510A
a 192.168.127.2 192.11
508A

5. Click Apply.
MXview archives configuration files from the selected device(s) to the MXview server.
For more information, see Comparing Archived Configuration Files.

Specify the location to save the exported configuration backup file.

7. Click Save.
MXview exports configurations from the selected device(s).

Comparing Archived Configuration Files

Use the MXview Configuration Center to compare changes in the history of saved configuration files.

1. Navigate to Menu (E) - Migrations > Configuration Center.
The Configuration Center screen appears.

2. Click the Records tab.
A list of archived configuration files appears.

Configuration Center

Configuration File @ =
Configuration File Createing Time Last Checking Time
a i !: 192.168.127.1_20181124_1752.ini 2018-11-24 17:52:00 2018-11-25 16:42:00
a i !J 192.168.127 2_20181124_1810.ini 2018-11-24 18:10:00 2018-11-24 22:58:00
B i !J 192.168.127 3_20181124_2218.ini 2018-11-24 22:18:00 2018-11-24 22:58:00
a i uﬂ 192168127 4_20181124_2218.ini 2018-11-24 22°18:00 2018-11-24 22:18:00
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3. (Optional) To filter the list of configuration files:
a. Click the Filter (<) icon.
b. Specify any of the following criteria:
e Group: The group that the device is assigned to
e Start Date: The earliest file creation date
e Start Time: The earliest file creation time on the Start Date
o End Date: The latest file creation or update date
e End Time: The latest file creation or update time on the End Date
c. Click Apply.
4. (Optional) To export configurations from all available devices:

a. Click the Export (@) icon.

&l =

Export CSV

b. Select Export CSV.
MXview exports configurations from all devices as a CSV file.

5. Click the Compare (lﬂ) icon next to the configuration file you want to compare.
The Compare Configurations screen will appear.

Compare Configurations

Compare basement: 192 168 127 1_20181124_1752.ini

Device List

192.168.127 1--IKS-6726A

192.168.127 2--IKS-6728A-8POE

192.168.127 .3--EDS-G516E Cancel

! 192.168.127 4--EDS-G516E

6. Select the device from the Device List drop-down list.
Select the target configuration file to compare from the Compare Target drop-down list.

8. Click Compare.
MXview will display a comparison of the selected configuration files.
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Compare Configurations

Compare basement: 192.168.127.2_20190110_1738.in
Device List

192.168.127 .2

Compare Target
192.168.127.2_20190110_1741.ini

[EtherDevice Server Configuration File]
# Model Name
ModelName= EDS-GS512E-8PoE

# System Identification

[System Identification]
# [SwitchName]: Switch Mame

# --> max. length = 35 words
SwitchName=

# [Location]: Switch Location
# --> max. length = 256 words

+ Location= switch Location123

# [SysDescr]: Switch Description
# --> max. length = 30 words -
74 - B »

Cancel Compare

The inserted, deleted, and modified lines in the configuration will be highlighted.

Creating Scheduled Jobs for
Database/Configuration Backups

Use the MXview Job Scheduler to automatically export/import device configurations or back up the MXview
database on a predefined schedule.

1. Navigate to Menu (E) - Migrations > Job Scheduler.
The Job Scheduler screen appears.

2. (Optional) To locate a previously saved scheduled job, type a job name in the search box.
The Job Scheduler table displays a list of matching scheduled jobs.

3. Click the Add (E3) button.
The Add new job screen appears.

4. Specify the Job Name.
Select one of the following options from the Action drop-down box:
o Export Configuration
¢ Import Configuration
o Database Backup
6. Type a Description for the job.
Select the Registered Devices that apply.

Select a job frequency from the Repeat Execution drop-down box:

e Once

* Daily

¢ Weekly
e Monthly

9. Specify the Start Date to begin executing the scheduled job.
10. Specify the Execution Time on the Start Date to run the scheduled job.

11. Click Apply.
MXview will display the scheduled job on the Job Scheduler table and will execute the job according the
defined schedule.
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Custom Integrations

MXview supports several features that enable integration with third-party applications or external systems.
The following topics are covered in this chapter:

O Managing API Keys
O Embedding Web Widgets
O Generating OPC Tags
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Managing API Keys

MXview supports several RESTful APIs for custom integrations with third-party products. Use the API Key
Management screen to add new applications and generate API keys.

1. Navigate to Menu (E) - Integration > RESTful API Management.
The API Key Management screen will appear.

APl Key Management

Type to filter APl keys

Delel  Application Name Create Time Access Count APl Key

i Demo 2018/11/14 13:37:43 1] GCIOWIUZITNIISINRSCCIGIKpXVCJ9.£) 2VybmFtZSIsImFKbWIUli
2ZDQ3N]I0ZDe2MMI
wxtsm_75QXFOnacD-

4Z[VhODRjNzAzMzBhYmI0Yzgzin0.Fox
0PB6IZUSINS_wUsrPFnk

2. (Optional) To filter the list of applications, type a string in the search box.

MXview filters the list of applications to display only the applications that contain full or partial matching
strings.

3. To add a new application:

a. Click the Add () icon in the top right corner of the screen.
The Add new token screen will appear.

Add new token

Application Name

Cance
b. Specify an Application Name.

c. Click Apply.

MXview will add the new application to the API Key Management screen and display the generated
API key.

4. To regenerate an API key for an existing application:

a. Select the check box next to the Application Name.
The Regenerate (G) icon will appear in the top right corner of the screen.

APl Key Management

v Delet  Application Name Create Time Access Count AP Key

v @ Demo 2018/11/14 13:37:43 0

eyJnbGCIOUIUZITNIISINRSCCIBIKpXVCJ9.eyJ1c2Vybi
0ljoXNTQyMTczODYzLCJqdG!
NODRjNZAZMZBRY mIDYzgzIn0.FoXRT2wxism
0PBSIZUSINS_wUsIPFnk

b. Click the Regenerate (®) icon.
MXview will regenerate the API key for the selected application.

NOTE Regenerating the API key will prevent any APIs that use the old API key from working properly.
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5. To delete an application:
a. Select the check box next to the Application Name.
b. Click the Delete (i) icon in either one of the following locations:
e Next to the Application Name.
e In the top right corner of the screen.

MXview will delete the application.

NOTE Deleting the application will prevent any APIs that use the old API key from working properly.

6. To view API reference documentation, navigate to Menu (E) - Integration > API Reference.
The MXview API screen will appear and display the reference document for supported MXview APIs.

MXview API <

A document of API for accessing data from MXview

Sthemes

HTTPS ~

Resource N7
/resources/icons/url/{url} Getdeviceicon
/resources/icons/{url} Gettheiconofasite
/resources/panel_images/url/{url} Getthe panelimage of a device

/resources/panel_descriptions/url/{url} Getdevice panel description file

Embedding Web Widgets

MXview allows you embed the Topology Map and Recent Events widgets from the MXview Network
Topology screen in third-party applications.

1. Navigate to Menu (E) - Integration > Embedded Web Widget.
The Embedded Widget screen will appear.

2. From the Select API Key drop-down list, select the Application Name for the API key you want to
use.

Select APl key

Demo -

3. From the Select Layout drop-down list, select the widget(s) you want to embed:

e Topology and recent events: Embeds both the Topology Map and Recent Events widgets in the
target application

e Topology: Embeds only the Topology Map in the target application

¢ Recent event: Embeds only the Recent Events widget in the target application
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4. Copy and paste the widget link for the target application:

To embed the widget in a web application, click the Copy link (D) icon in the Link section.

Embed
Link

2 0

Paste this into any HTML page

<iframe id="mxview-topology”
src="http://127.0.0_1/#/widget?
token=eyJhbGciOiJIUzI1NilsInR5cCl6lkpXWVC
J9 eyJ1c2VybmHZSIBImFKbWIuliwiaWFOljox
NTQyMTczODYzLCJgdGkiQilzMzFIZjQ2ZD0Q
3NJIOZDe2MVIMDM4ZIVhODRINzAzMzBhY
mi0YzgzIn0.FoxRT2wxtsm_75QXFOnacD-
0PB6IzUSINS_wUsrPFnk&layout=2&top=1&b
ottom=2" frameborder="0" scrolling="0"
style="border-radius: 2px; box-shadow:
rgba(0, 0, 0, 0.12) Opx Opx 2px Opx, rgba(0, 0,
0, 0.24) Opx 2px 2px Opx; width: 600px;
height: 600px;"=</iframe= n|

To embed the link in a static HTML page, click the Copy link (rD) icon in the Paste this into any

HTML page section.

Embed
Link

http://127 0.0 1/#/widget?
token=eyJhbGciOiJIUzINilsInR5cClEIkpXWC
J9 eyJ1c2VybmFtZSIBImFkbWiuliwiaWFOljox
NTQyMTczODYzLCJqdGkiQilzMzFIZjQ27DQ
INJIOZDc2MVIMDMAZIVhODRNzAZMzBhY
ml0YzgzIn0.FoxRT2wxtsm_75QXFOnacD-
0PB6IzUSINS_wUsrPFnk&layout=2&top=1&b
ottom=2 0

Paste this into any HTML page

<iframe id="mxview-topology™
src="hitp://127 0.0_1H##/widget?
oken=eyJhbGciOiJIUzI1NilsInR3cCl61kpXVC|
9 _eyJ1c2VybmHZSI6ImFkbWiluliwiaWFOljox
NTQyMTczODYzL CJqdGkiOilzMzFZjQ2Z2DQ
NjI0ZDc2MVIMDMAZIVhODRINzAZMzBhY

height: 600px;
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Generating OPC Tags

MXview can generate OPC 2.0-compliant tags of device and link properties. OPC clients such as SCADA
Systems can access and use these tags.

Currently, the default information that MXview can prepare as tags includes:

¢ A Health tag, which represents the health status of whole network.
e Device IP address, MAC address, and status, which are labeled beginning with D_.

e Alink's corresponding IP address and ports, which are labeled beginning with L_.

NOTE

The Health tag represents the health status of the entire network. There are three levels: Normal, Warning,
and Critical, with the values 0, 1, and 2 respectively. MXview allows users to use only one tag to monitor
the status of the whole network.

In addition to the default OPC tags, MXview allows you to add custom OPC tags for supported SNMP device
properties.

1. To enable the OPC server and start generating default OPC tags:

a. Navigate to Menu (E) - Preferences.
The Preferences screen will appear.

b. In the Server section, expand OPC Server Configuration.
The OPC Server Configuration settings will appear.

Server
Syslog Server Configuration v
EMail Server Setup v
SMS Setting w
OPC Server Configuration % ~ |
E;at;led -

c. From the Enable drop-down list, select Enabled.

d. Click Save.
MXview will enable the OPC server and start generating default OPC tags.

2. To add custom OPC tags:

a. Navigate to Menu (E) - Integration > Custom OPC Tags.
The Custom OPC Tags screen will appear.

Custom OPC Tags
All©Q) pe to filter custom OPC tags =
Property Name Enabled/Disabled Register devices

Enabled (0)

Disabled (0)
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b. Click the Add () icon in the top right corner.
The Add custom OPC tags screen will appear.

Add custom OPC tags

Enabled Custom OPC tags v

(]
T
o
v
=]
)
1
1]

T
s}
W
o
@
=
T
w
4

Cancel

c. Configure the following:

e Enabled Custom OPC tags: Select to enable to disable the custom OPC tags

e Device Properties: Select the SNMP properties to generate custom OPC tags

o Registered Devices: Select the devices to implement the custom OPC tags

d. Click Apply.

MXview creates custom OPC tags for the selected SNMP device properties.

3. (Optional) Filter the list of custom OPC tags displayed in the table:

e Use the search box to type a full or partial string that matches the value in any of the table columns.

Type to filter custom OPC tags

MXview filters the table to only display OPC tags with values that fully or partially match the specified

string.

e Click one of the following OPC tag statuses on the left side of the screen.

All (0)

Enabled (0)

Disabled (0)

MXview filters the table to only display OPC tags that match the selected status.

4. To export the data displayed on the Custom OPC Tags screen:

a. Click the Export (E) icon.

Export CSV

b. Select Export CSV.
c. Specify the location to save the exported file.
d. Click Save.

MXview exports the displayed event data as a CSV file.
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License

License (Net-SNMP)

Various copyrights apply to this package, listed in several separate sections below.

Please carefully review all sections of the license information.
---- Part 1: CMU/UCD copyright notice: (BSD like) -----
Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000. The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES WITH REGARD
TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO
EVENT SHALL CMU OR THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL,

INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS
OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----

Copyright (c) 2001-2003, Networks Associates Technology, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
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* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright © 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara,

California 95054, U.S.A. All rights reserved.
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Use is subject to license terms below.
This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----

Copyright (c) 2003-2009, Sparta, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
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HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network
Center of Beijing University of Posts and Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDERS OR

CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY,

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----

Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003
oss@fabasoft.com

Author: Bernhard Penz

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
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* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----

Copyright (c) 2007 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. (“"Apple”) nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: Sciencelogic, LLC copyright notice (BSD) -----

Copyright (c) 2009, Sciencelogic, LLC

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:



MXview 3.1.4 License

The

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of SciencelLogic, LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

MIT License (Libxml2)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the “Software”), to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software,
and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions
of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT
OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

License Agreement (GoAhead)

THIS LICENSE AGREEMENT IS BETWEEN YOU AND GOAHEAD (BOTH AS DEFINED BELOW). THIS
AGREEMENT GRANTS YOU ONLY A LIMITED LICENSE TO USE GOAHEAD PROPRIETARY COMPUTER
SOFTWARE. BY EXECUTING THIS AGREEMENT OR USING THE SOFTWARE, YOU CERTIFY THAT YOU WILL
USE THE SOFTWARE ONLY IN THE MANNER PERMITTED HEREIN.

1. Definitions.

“Documentation” means any documentation GoAhead provides with the Original Code.
“GoAhead” means GoAhead Software, Inc.

“Agreement” means this document.

“Modifications” means any addition to or deletion from the substance or structure of either the Original
Code or any previous Modifications.

“Original Code” means the source code to GoAhead’s proprietary computer software entitled GoAhead
WebServer that is provided to You by GoAhead.
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“You"” means an individual or a legal entity exercising rights under, and complying with all of the terms of,
this license or a future version of this license. For legal entities, “You” includes any entity that controls, is
controlled by, or is under common control with You. For purposes of this definition, “control” means (a) the
power, direct or indirect, to cause the direction or management of such entity, whether by contract or
otherwise, or (b) ownership of fifty percent (50%) or more of the outstanding shares or beneficial ownership
of such entity.

“Response Header” means the first portion of the response message output by the GoAhead WebServer,
containing but not limited to, header fields for date, content-type, server identification and cache control.

“Server Identification Field” means the field in the Response Header which contains the text “Server:
GoAhead-Webs”.

2. License.
Limited Original Code Grant.

Subject to the terms of this Agreement, GoAhead hereby grants You a worldwide, royalty-free,
nonexclusive, nontransferable license, without right of sublicense, subject to third party intellectual property
claims, (a) to use and reproduce the Original Code, (b) to create Modifications from the Original Code, and
(c) to distribute source code copies of the Original Code form solely when embedded in other software (in a
manner that does not allow the Original Code to be separated) that provides material functionality in
addition to the functionality provided by the Original Code.

Binary Code.

Subject to the terms of this Agreement, GoAhead hereby grants You a worldwide, royalty-free,
nonexclusive, nontransferable license, without right of sublicense, to copy and distribute binary code copies
of the Original Code together with Your Modifications in binary code.

Restrictions on Use.

You may sublicense third parties to use Your Modifications if You enter into a license agreement with such
third parties that bind such third parties to all the obligations under this Agreement applicable to You and
that are otherwise substantially similar in scope and application to this Agreement (without limiting the
protections afforded to GoAhead). You may not rent, lease, or loan the software.

Documentation.

Subject to the terms of this Agreement, GoAhead hereby grants You a worldwide, royalty-free,
nonexclusive, nontransferable license, without right of sublicense, to copy and distribute the Documentation
in connection with the authorized distribution of the Original Code and Modifications.

Copyright Notice.

You agree to include copies of the following notice (the “Notice”) regarding proprietary rights in all copies of
the Original Code and Modifications that You distribute, as follows: (a) embedded in the binary code; and
(b) on the title pages of all documentation. Furthermore, You agree to use commercially reasonable efforts
to cause any licensees of your products to embed the Notice in object code and on the title pages or
relevant documentation. The Notice is as follows: Copyright (c) 20XX GoAhead Software, Inc. All Rights
Reserved. Unless GoAhead otherwise instructs, the year 20xx is to be replaced with the year during which
the release of the Original Code containing the notice is issued by GoAhead. If this year is not supplied with
Documentation, GoAhead will supply it upon request.

License Back to GoAhead.

You hereby grant in both source code and binary code to GoAhead a world-wide, royalty-free, non-exclusive
license to copy, modify, display, use and sublicense any Modifications You make that are distributed or
planned for distribution. Within 30 days of either such event, You agree to ship to GoAhead a file containing
the Modifications (in a media to be determined by the parties), including any programmers’ notes and other
programmers’ materials. Additionally, You will provide to GoAhead a complete description of the product,
the product code or model number, the date on which the product is initially shipped, and a contact name,
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phone number and e-mail address for future correspondence. GoAhead will keep confidential all data
specifically marked as such.

3. Terms, Trademards and Brand.
License and Use.

GoAhead hereby grants to You a limited world-wide, royalty-free, non-exclusive license to use the GoAhead
trade names, trademarks, logos, service marks and product designations posted in Exhibit A (collectively,
the “"GoAhead Marks"”) in connection with the activities by You under this Agreement. Additionally, GoAhead
grants You a license under the terms above to such GoAhead trademarks as shall be identified at a URL (the
“"URL") provided by GoAhead. The use by You of GoAhead Marks shall be in accordance with GoAhead’s
trademark policies regarding trademark usage as established at the Web site designated by the URL, or as
otherwise communicated to You by GoAhead at its sole discretion. You understand and agree that any use
of GoAhead Marks in connection with this Agreement shall not create any right, title or interest in or to such
GoAhead Marks and that all such use and goodwill associated with GoAhead Marks will inure to the benefit
of GoAhead.

Promotion by You of GoAhead WebServer Mark.

In consideration for the licenses granted by GoAhead to You herein, You agree to notify GoAhead when You
incorporate the GoAhead WebServer in Your product and to inform GoAhead when such product begins to
ship. You agree to promote the Original Code by prominently and visibly displaying a graphic of the
GoAhead WebServer mark on the initial Web page of Your product that is displayed each time a user
connects to it. You also agree that GoAhead may identify your company as a user of the GoAhead
WebServer by placing your company logo on its Web site. You may further promote the Original Code by
displaying the GoAhead WebServer mark in marketing and promotional materials such as the home page of
your Web site or Web pages promoting the product. You also agree to use the latest available logo and
script code from GoAhead available from the official GoAhead download location.

No Modifications to Server Identification Field.

You agree not to remove or modify the Server identification Field contained in the Response Header as
defined in Section 1.7 and 1.8.

4. Term.

This Agreement and license are effective from the time You execute this Agreement until this Agreement is
terminated. You may terminate this Agreement at any time by uninstalling or destroying all copies of the
Original Code including all binary versions and removing any Modifications to the Original Code existing in
any products. This Agreement will terminate immediately and without further notice if You fail to comply
with any provision of this Agreement. All restrictions on use, and all other provisions that may reasonably
be interpreted to survive termination of this Agreement, will survive termination of this Agreement for any
reason. Upon termination, You agree to uninstall or destroy all copies of the Original Code, Modifications,
and Documentation.

5. Warranty Disclaimers.

THE ORIGINAL CODE, THE DOCUMENTATION, AND THE MEDIA UPON WHICH THE ORIGINAL CODE IS
RECORDED (IF ANY) ARE PROVIDED “AS IS” AND WITHOUT WARRANTIES OF ANY KIND, EXPRESS,
STATUTORY OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND NON-INFRINGEMENT.

The entire risk as to the quality and performance of the Original Code (including any Modifications You
make) and the Documentation is with You. Should the Original Code or the Documentation prove defective,
You (and not GoAhead or its distributors, licensors or dealers) assume the entire cost of all necessary
servicing or repair. GoAhead does not warrant that the functions contained in the Original Code will meet
your requirements or operate in the combination that You may select for use, that the operation of the
Original Code will be uninterrupted or error free, or that defects in the Original Code will be corrected. No
oral or written statement by GoAhead or by a representative of GoAhead shall create a warranty or increase
the scope of this warranty.
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GOAHEAD DOES NOT WARRANT THE ORIGINAL CODE AGAINST INFRINGEMENT OR THE LIKE WITH
RESPECT TO ANY COPYRIGHT, PATENT, TRADE SECRET, TRADEMARK OR OTHER PROPRIETARY OR
INTELLECTUAL PROPERTY RIGHT OF ANY THIRD PARTY AND DOES NOT WARRANT THAT THE ORIGINAL
CODE DOES NOT INCLUDE ANY VIRUS, SOFTWARE ROUTINE OR OTHER SOFTWARE DESIGNED TO PERMIT
UNAUTHORIZED ACCESS, TO DISABLE, ERASE OR OTHERWISE HARM SOFTWARE, HARDWARE OR DATA,
OR TO PERFORM ANY OTHER SUCH ACTIONS.

Any warranties that by law survive the foregoing disclaimers shall terminate 90 days from the date You
received the Original Code.

6. Limitation of Liability.

YOUR SOLE REMEDIES AND GOAHEAD'S ENTIRE LIABILITY ARE SET FORTH ABOVE. IN NO EVENT WILL
GOAHEAD OR ITS DISTRIBUTORS OR DEALERS BE LIABLE FOR DIRECT, INDIRECT, INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THE ORIGINAL CODE, THE INABILITY TO USE
THE ORIGINAL CODE, OR ANY DEFECT IN THE ORIGINAL CODE, INCLUDING ANY LOST PROFITS, EVEN IF
THEY HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

You agree that GoAhead and its distributors and dealers will not be LIABLE for defense or indemnity with
respect to any claim against You by any third party arising from your possession or use of the Original Code
or the Documentation.

In no event will GoAhead’s total liability to You for all damages, losses, and causes of action (whether in
contract, tort, including negligence, or otherwise) exceed the amount You paid for this product.

SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, AND SOME
STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES,
SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU
SPECIFIC LEGAL RIGHTS AND YOU MAY HAVE OTHER RIGHTS THAT VARY FROM STATE TO STATE.

7. Indemnification by You.

You agree to indemnify and hold GoAhead harmless against any and all claims, losses, damages and costs
(including legal expenses and reasonable counsel fees) arising out of any claim of a third party with respect
to the contents of the Your products, and any intellectual property rights or other rights or interests related
thereto.

8. High-Risk Activities.

The Original Code is not fault-tolerant and is not designed, manufactured or intended for use or resale as
online control equipment in hazardous environments requiring fail-safe performance, such as in the
operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life
support machines or weapons systems, in which the failure of the Original Code could lead directly to death,
personal injury, or severe physical or environmental damage. GoAhead and its suppliers specifically disclaim
any express or implied warranty of fitness for any high-risk uses listed above.

9. Government Restricted Rights.

For units of the Department of Defense, use, duplication, or disclosure by the Government is subject to
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software
clause at DFARS 252.227-7013. Contractor/manufacturer is GoAhead Software, Inc., 10900 N.E. 8th Street,
Suite 1200, Bellevue, Washington 98004.

If the Commercial Computer Software Restricted rights clause at FAR 52.227-19 or its successors apply, the
Software and Documentation constitute restricted computer software as defined in that clause and the
Government shall not have the license for published software set forth in subparagraph (c)(3) of that
clause.

The Original Code (i) was developed at private expense, and no part of it was developed with governmental
funds; (ii) is a trade secret of GoAhead (or its licensor(s)) for all purposes of the Freedom of Information
Act; (iii) is “restricted computer software” subject to limited utilization as provided in the contract between
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the vendor and the governmental entity; and (iv) in all respects is proprietary data belonging solely to
GoAhead (or its licensor(s)).

10. Governing Law and Interpretation.

This Agreement shall be interpreted under and governed by the laws of the State of Washington, without
regard to its rules governing the conflict of laws. You hereby consent to the exclusive jurisdiction of the
state and federal courts located in King County, Washington over any disputes arising out of related to this
Agreement. If any provision of this Agreement is held illegal or unenforceable by a court or tribunal of
competent jurisdiction, the remaining provisions of this Agreement shall remain in effect and the invalid
provision deemed modified to the least degree necessary to remedy such invalidity.

11. Entire Agreement.

This Agreement is the complete agreement between GoAhead and You and supersedes all prior agreements,
oral or written, with respect to the subject matter hereof.

License (OpenSSL)

This is a copy of the current LICENSE file inside the CVS repository.

LICENSE ISSUES

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the
original SSLeay license apply to the toolkit.

See below for the actual license texts. Actually both licenses are BSD-style Open Source licenses. In case of
any license issues related to OpenSSL please contact openssl-core@openssl.org.

OpenSSL License

* Copyright (c) 1998-2008 The OpenSSL Project. All rights reserved.

* Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment: “This product includes software developed by the OpenSSL Project for use in the
OpenSSL Toolkit. (http://www.openssl.org/)”

4. The names “"OpenSSL Toolkit” and "OpenSSL Project” must not be used to endorse or promote products
derived from this software without prior written permission. For written permission, please contact
openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL” nor may “"OpenSSL” appear in their
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: “This product
includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)”
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THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

* This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are aheared

to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc.,
code; not just the SSL code. The SSL documentation included with this distribution is covered by the same

copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

* Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be removed.

* If this package is used in a product, Eric Young should be given attribution as the author of the parts of
the library used.

* This can be in the form of a textual message at program startup or in documentation (online or textual)
provided with the package.

* Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: “This product includes cryptographic software written by Eric Young
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(eay@cryptsoft.com)”"The word “cryptographic” can be left out if the rouines from the library being used
are not cryptographic related :).

4. 1If you include any Windows specific code (or a derivative thereof) from the apps directory (application
code) you must include an acknowledgement: “This product includes software written by Tim Hudson
(tjh@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

* The licence and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution licence [including the
GNU Public Licence.]

/

License (zlib)

/* zlib.h -- interface of the “zlib” general purpose compression library version 1.2.3, July 18th, 2005
Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided “as-is”, without any express or implied warranty. In no event will the authors be
held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications,
and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original
software. If you use this software in a product, an acknowledgment in the product documentation would
be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the
original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly jloup@gzip.org

Mark Adler madler@alumni.caltech.edu
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